Validation Procedure for DII COE Kernel Platform Compliance: Segment Installer Validation Procedure


Test Title: Segment Installation Validation Procedure - DRAFT

Candidate Platform:  



Date:  


Tester:  



Estimated Runtime:  8 hours


Start Time:  

End Time:  

Actual Runtime:  

Test Site/Organization:  



Overall Test Result (Circle One):    PASS / FAIL

Configuration Validated

Hardware Platform:  



System Software:  

Network Type:  



Printer:  

Local Devices (if any):  





Test Purpose/Scope: This test procedure has been structured to cover the verification of proper segment installation by testing the features and functions of the Segment Installer and the Segment Installation Server.  In addition the test segments suite supplied will validate that the Segment Installer will install segment types and segment descriptors correctly and consistent with the DII COE I&RTS  Sections 4.3,4.4 & 6 (Rev 4.0 date October 25, 1999.

This test also assures that the Graphical User Interface (GUI) presented to the user for basic system operation is consistent across all compliant POSIX-based DII COE platforms.  This test assures that the operations invoked and exercised have identical results that are consistent across all compliant POSIX-based Defense Information Infrastructure (DII) Common Operating Environment (COE) platforms.

Description: The demonstration suite for the Segment Installer and Segment Installation Server uses segments that are supplied to the tester in Configuration Management (CM) “cooked segment” format on both 8mm tape and CD.  Tests listed below are designed to check the interoperability and integrity of the Segment Installer and Segment Installation Server with respect to both the commercial operating system and the DII COE environment.

This test procedure exercises the following functions:

A. Pretest Setup
B. Verify Segment Installer Feature Availability
C. Local Devices Testing
D. Remote Device Testing
E. Test the Runtime Tools
F. Segment Type Tests
G. Test the Process descriptor
H. Verify Segment Installer will process Conflicts descriptor
I. Verify Segment Installer will process Requires descriptor
J. Network Installation Server / Segment Installation Server Testing - Verify Feature Availability
K. Local Devices Testing
L. Remote Device Testing
M. Network Installation Server / Segment Installation Server Testing – Load many Segments
N. Verify  Segment Installation Server on the Candidate Platform (kpccp) can read Table of Contents and Install Segments from the Network Installation Server / Segment Installation Server
O. Verify Segment Installation Server on the Validation Host (kpchost) can read Table of Contents and Install Segments from the Network Installation Server / Segment Installation Server
P. Network Installation Server / Segment Installation Server Testing – Verify Segments Deinstall Correctly
Q. Launch Installer from the Command Line
R. Segment Installation Post Test Cleanup (Candidate Platform)
S. Segment Installation Post Test Cleanup (Validation Host)
Z. Log out on the Candidate Platform (kpccp) and Validation Host (kpchost)
Appendix A
AZ.   Setup – Create Test Data Tape that includes segx
Overall Test Result:  The overall PASS/FAIL result for this test is determined as follows:  The overall test result is "PASS" if and only if all steps marked as PASS/FAIL steps in the Observed Result column, have a test step "PASS" result.

Test Step Results:  For each step with a "Circle One:  PASS/FAIL" in the Observed Result column, the tester compares the directly observed Candidate Platform behavior with the "PASS" criteria.  Unless other PASS criteria are noted in the test step, the test step result is "PASS" if and only if the Candidate Platform presents all of the behaviors and conditions described in the Expected Result column for that test step.  The test step result is "FAIL" if the Candidate Platform fails to satisfy any of the PASS criteria.

If the test step result is "PASS", the tester will circle "PASS" and note the actual behaviors and conditions presented in the Observed Result column.  If the observed result precisely matches the expected result, the Observed Result column for the step may contain the statement "as expected.”

If the test step result is "FAIL", the tester will circle "FAIL" in the Observed Result column and note the actual behaviors and conditions presented in the Observed Result column.  Additional documentation detailing the reasons for the test step failure is included in the Validation Test Report.

Note 1:  Due to the complexity of any Candidate Platform, it is impossible to completely specify all aspects of their operation in the space provided.  Many of the expected Candidate Platform behaviors for any test step are implicitly assumed based on industry practice, commercial testing or prior testing, and may not be explicitly described in the Expected Result column.  DISA reserves the right to consider implicit as well as explicit PASS/FAIL criteria which could adversely affect the ability of the Candidate Platform to satisfy DoD mission requirements when used as a component of the DII.

If implicit PASS/FAIL criteria are involved in a "FAIL" determination, the tester will circle "FAIL" in the Observed Result column and note the objectionable behavior in the Observed Result column at the point of observation during the test.  Additional documentation detailing the full rationale for the "FAIL" determination is to be included in the Validation Test Report.

Note 2:  Test steps which are "grayed out" (i.e., the entire table row is set to a gray background) are to be considered as waived by DISA for this test version only.  Grayed out test steps are not to be executed nor is observed behavior to be recorded.  These test steps may be returned to the overall test at a future date and are retained for information purposes only.  PASS/FAIL criteria identified in these test steps will not be used in the determination of the overall test result.

Note 3:  Lower case “s” in brackets [s] denotes a blank space; lower case “r” in brackets [r] denotes a carriage return; lower case “s” and “r” together in brackets [s] [r] denotes a blank space and carriage return.

Test Data/Media Required:  KPC Test Data Repository on CD and 8mm tape (Note: If test data tape is not available, Appendix A is a procedure to create the tape required for this test). This includes segx.tar and kpctestdata.tar.
Setup/Equipment Required: This test requires a Validation Host and Candidate Platform configured as specified in the current version of the DII COE Setup Procedures for Kernel Platform Compliance (KPC) Validation Cell for Kernel V4.2.0.0P4 (Solaris 8) document.
(1) Candidate Platform (kpccp) with internal hard drive, CD drive, tape drive and network interface.

(2) Validation Host   (kpchost) with internal hard drive, CD drive, tape drive and network interface.

(3) The Validation Host (kpchost) is configured as the DNS name server for both the Candidate Platform (kpccp) and the Validation Host (kpchost).

Required Personnel:  One (1) tester.  The tester must be familiar with POSIX/UNIX application platforms, but need not be familiar with the Defense Information Infrastructure (DII) Common Operating Environment (COE).

Known Problems: 

1. There is a known problem with the way the Installer and Network Installation Server recalculate disk usage after certain installer functions. If the displayed values are wrong, they may be correctly recalculated by closing and reopening the Installer or Network Installation Server. If this is done, subsequent test steps may have to be modified, for example, it will be necessary to enter the Authentication Key again. The correct Available Disks and/or Reserved Space setting may need to be reselected.

2. Due to a P4 bug, the Network Installation Server may die upon loading segments.  If this happens, re-open it and re-select the appropriate line in the Available Disks field.  The segment should be loaded at this point.

Change History:

03 July 01
In header line - Changed Installation to Installer.



Step A.4.3 - Added note to ER.



Step G.4.2 - Added “Double-click proc_prof” to the OA;  separated results in ER.



Step H.1.14 - Added “In the Filter box type: /kpc/si/*” to OA.



Step J.9.15 - Changed Rm to rm.



Step K.1 - Changed sever to server.



Step L.4.4 - Grayed out step.



Step M.2.12 - Added “cpp” to list in ER.

End of Preamble

	
	Operator Action
	Expected Result
	Observed Result

	A
	Pretest Setup

	A.1
	Test Data Installation
	

	A.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Login as sysadmin.
	The desktop appears.
	Startup

	A.1.2
	Insert the DII COE Kernel and Toolkit Source Code, Test Data, and Documentation CD-ROM into the CD-ROM drive.
	The CD-ROM is inserted.
	Startup

	A.1.3
	Select Applications > Application Manager > DII_APPS.
	The Application Manager window appears.
	Startup 



	A.1.4
	Double-click Segment Installer in the Application Manager – SysAdm window.
	The  Installer window appears.
	Setup 



	A.1.5
	Click Select Source.
	Select Source is selected.
	Setup 


	A.1.6
	Click CD-ROM.
	CD-ROM is selected.
	Setup 


	A.1.7
	Click TD42P4.tar.
	TD42P4.tar is selected.
	Setup 


	A.1.8
	Click OK.
	The Installer window reappears.
	Setup 


	A.1.9
	Click Read Contents.
	The Installer window disappears while message boxes appear informing that the system is Checking media and then Read Contents in progress.

The Installer window reappears with KPC Test Data for 4200P4 listed under Select Software To Install.
	Setup 



	A.1.10
	Select the KPC Test Data for 4200P4. 
	KPC Test Data for 4200P4 is highlighted.
	Setup 



	A.1.11
	Click Install.
	AN ENTER A PASSWORD dialog box appears.
	Setup 



	A.1.12
	Enter the APM Authentication key in the text box.
	Asterisks appear in the text box.
	Setup 



	A.1.13
	Click OK.
	The dialog box disappears. 

A RESPOND TO THE MESSAGE dialog box appears with the message 

Please insert CD Volume #1 for the segment ‘KPC TEst Data for 4200P4! When you are ready press the OK button.
	Setup 

	A.1.14
	Click OK.
	An INFORMATIONAL MESSAGE dialog box opens informing that the KPC Test Data for 4200P4 has been installed.
	Setup 



	A.1.15
	Click OK.
	The Installer window reappears.
	Setup 



	A.1.16
	Verify that KPC Test Data for 4200P4 appears in the list under Currently Installed Segments.
	KPC Test Data for 4200P4 appears in the list under Currently Installed Segments.
	Setup 



	A.1.17
	Eject the CD-ROM.
	The CD-ROM ejects.
	Setup 



	A.1.18
	Click Exit.
	The Installer window disappears.
	Setup 



	A.2
	Setup – Create Directories On the Candidate Platform (kpccp)
	

	A.2.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Open a Terminal window.
	A Terminal window appears with a command line prompt.
	Startup

	A.2.2
	At the command prompt type 

su 

NOTE: Do not use the "-" option.
	The Password prompt returns.
	Startup

	A.2.3
	Enter the root password.
	The command prompt returns.
	Startup



	A.2.4
	At the command prompt type 

csh
	The command prompt returns.
	Startup

	A.2.5
	At the command prompt type

cd /
	The command prompt returns.
	Startup

	A.2.6
	At the command prompt type                                  df –k

NOTE: For The Segment Installation Validation Procedures Tests to run correctly, the following partitions must be mounted.

/h, /home1, /home2. 
	The following partitions are listed:

 .  .  .  /h
 .  .  .  /home1
 .  .  .  /home2


	Setup

	A.2.7
	At the command prompt type

mkdir /kpchostdsk /kpchostcdrom
	The command prompt returns.
	Setup 



	A.3
	Edit Local Hosts On the Candidate Platform (kpccp)
	

	A.3.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Select Applications > Application Manager > DII_APPS > SysAdm.
	The Application Manager – SysAdm window appears.
	Setup

	A.3.2
	 Double-click Edit Local Hosts.      
	The Edit Hosts window appears.
	Setup



	A.3.3
	 Click Add.
	The Add Machine window appears.
	Setup



	A.3.4
	 In the Add Machine window, type:

 Machine Name:  kpchost
 Machine Address:  204.34.175.194
	Input is accepted.
	Setup

	A.3.5
	 Click OK.
	The Add Machine window disappears and the new kpchost host entry appears in the Edit Hosts window.
	Setup

	A.3.6
	 Click Close.
	The Edit Hosts window disappears.
	Setup



	A.4
	Setup – Modify /etc/inetd.conf and /.rhosts To Enable rsh (Open Security For Remote Shell) On the Candidate Platform (kpccp)
	

	A.4.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Terminal window, at the command prompt type

vi /etc/inetd.conf
	The file /etc/inetd.conf is opened for editing.
	Setup 



	A.4.2
	Type

/#shell
	The vi editor will place the cursor on the line that contains:

#shell
	Setup 



	A.4.3
	Type

x
	The vi editor will remove the # symbol.

Note: There may be more than one line beginning with #shell.  Remove the ‘#’ for all occurences.
	Setup 



	A.4.4
	Type

:wq!
	The vi editor will write to and exit the file.

The command prompt returns.
	Setup 



	A.4.5
	At the command prompt type

ps –eaf | grep inetd
	Process information for inetd appears with the process ID in the second column.
	Setup 



	A.4.6
	At the command prompt type

kill –HUP <pid>
where <pid> is the process ID found in the previous step.
	The command prompt returns.
	Setup 



	A.4.7
	In the Terminal window, at the command prompt type

vi /.rhosts
	The file /.rhosts is opened for editing.
	Setup 



	A.4.8
	Type

x
	The vi editor will removes the - symbol.
	Setup 



	A.4.9
	Type

i
	The vi editor enters Insert Mode.
	Setup 



	A.4.10
	Type

kpchost 
	The vi editor inserts kpchost to the file.
	Setup 



	A.4.11
	Press

[esc]
	The vi editor exits Insert Mode.
	Setup 



	A.4.12
	Type

:wq!
	The vi editor will write to and exit the file.  

The command prompt returns.
	Setup 



	A.5
	Setup – Export  /h/data/global and /home2 Directories From the Candidate Platform (kpccp)
	

	A.5.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Application Manager – SysAdm window, double-click Disk Manager.
	The Disk Manager window appears.
	Setup



	A.5.2
	Select the row that contains the / partition in the Mounted On column.
	The row is highlighted.
	Setup



	A.5.3
	Click Export FS.
	The Export/Unexport File Systems window appears.
	Setup

	A.5.4
	In the options text box, type:

rw,root=kpchost
	rw,root=kpchost appears in the options text box.
	Setup



	A.5.5
	In the pathname text box, type: 

/h/data/global
	/h/data/global appears in the pathname text box.
	Setup

	A.5.6
	Click Export.
	A Confirmation window appears asking: Export this directory permanently?
	Setup

	A.5.7
	Click Yes.
	The Confirmation window disappears and control returns to the Disk Manager window.
	Setup

	A.5.8
	Select the row that contains the /home2 partition in the Mounted On column.
	The row is highlighted.
	Setup



	A.5.9
	Click Export FS.
	The Export/Unexport File Systems window appears.
	Setup

	A.5.10
	In the options text box, type:
ro,root=kpchost
	ro,root=kpchost appears in the options text box.
	Setup



	A.5.11
	In the pathname text box, verify /home2 is present.
	/home2 appears in the pathname text box.
	Setup

	A.5.12
	Click Export.
	A Confirmation window appears asking: Export this directory permanently?
	Setup

	A.5.13
	Click Yes.
	The Confirmation window disappears and control returns to the Disk Manager window.
	Setup

	A.5.14
	In the Terminal window, at the command prompt type

share
	The following text is displayed:

/h/data/global rw,root=kpchost
/home2 ro,root=kpchost
	Setup

	A.6
	Edit Local Hosts On the Validation Host (kpchost)
	

	A.6.1
	NOTE: Perform the following steps on the Validation Host (kpchost).

Login as sysadmin.
	The desktop appears.
	Setup

	A.6.2
	Select Applications > Application       Manager > DII_APPS > SysAdm.
	The Application Manager – SysAdm window appears.
	Setup

	A.6.3
	 Double click Edit Local Hosts.
	The Edit Hosts window appears.
	Setup



	A.6.4
	Click Add.
	The Add Machine window appears.
	Setup



	A.6.5
	In the Add Machine window type:

Machine Name:  kpccp
Machine Address:  204.34.175.195
	Input is accepted.
	Setup

	A.6.6
	Click OK.
	The Add Machine window disappears and the new kpccp host entry appears in the Edit Hosts window.
	Setup

	A.6.7
	Click Close.
	The Edit Hosts window disappears.
	Setup



	A.7
	Setup – Modify /etc/inetd.conf and /.rhosts To Enable rsh (Open Security For Remote Shell) On the Validation Host (kpchost)
	

	A.7.1
	NOTE: Perform the following steps on the Validation Host (kpchost).

Open a Terminal window.
	A Terminal window appears with a command line prompt.
	Startup

	A.7.2
	At the command prompt type 

su
	The Password prompt appears.
	Startup

	A.7.3
	Enter the root password.
	The command prompt returns.
	Startup



	A.7.4
	At the command prompt type 

csh
	The command prompt returns.
	Startup

	A.7.5
	At the command prompt type

vi /etc/inetd.conf
	The file /etc/inetd.conf is opened for editing.
	Setup 



	A.7.6
	At the command prompt type

/#shell
	The vi editor will place the cursor on the line that contains:

#shell
	Setup 



	A.7.7
	At the command prompt type

x
	The vi editor will remove the # symbol.
	Setup 



	A.7.8
	At the command prompt type

:wq!
	The vi editor will write to and exit the file.  

The command prompt returns.
	Setup 



	A.7.9
	At the command prompt type

ps –eaf | grep inetd
	Process information for inetd appears with the process ID in the second column.
	Setup 



	A.7.10
	At the command prompt type

kill –HUP <pid>
where <pid> is the process ID found in the previous step.
	The command prompt returns.
	Setup 



	A.7.11
	At the command prompt type

vi /.rhosts
	The file /.rhosts is opened for editing.
	Setup 



	A.7.12
	Type

x
	The vi editor will removes the – symbol.
	Setup 



	A.7.13
	Type

i
	The vi editor enters Insert Mode.
	Setup 



	A.7.14
	Type

kpccp
	The vi editor inserts kpccp to the file.
	Setup 



	A.7.15
	Press

[esc]
	The vi editor exits Insert Mode.
	Setup 



	A.7.16
	Type

:wq!
	The vi editor will write to and exit the file. 

 The command prompt returns.
	Setup 



	A.8
	Setup – Export /kpc, /cdrom/kpc_4204, and /home2 On the Validation Host (kpchost)
	

	A.8.1
	NOTE: Perform the following steps on the Validation Host (kpchost).

Insert the KPC Test Data CD-ROM into the CD-ROM drive.
	The CD-ROM is inserted.
	Setup

	A.8.2
	In the Application Manager – SysAdm window, double-click Disk Manager.
	The Disk Manager window appears.
	Setup

	A.8.3
	Select the row that contains the / partition in the Mounted On column.
	The row is highlighted.
	Setup



	A.8.4
	Click Export FS.
	The Export/Unexport File Systems window appears.
	Setup

	A.8.5
	Type ro=kpccp in the options text box.
	ro=kpccp appears in the options text box.
	Setup



	A.8.6
	In the pathname text box, type: 

/kpc
	/kpc appears in the pathname text box.
	Setup

	A.8.7
	Click Export.
	A Confirmation window appears asking: Export this directory permanently?
	Setup

	A.8.8
	Click YES.
	The Confirmation window disappears and control returns to the Disk Manager window.
	Setup

	A.8.9
	Click Export FS.
	The Export/Unexport File Systems window appears.
	Setup

	A.8.10
	Type ro=kpccp in the options text box.
	ro=kpccp appears in the options text box.
	Setup



	A.8.11
	In the pathname text box, type: 

/cdrom/kpc_4204
	/cdrom/kpc_4204 appears in the pathname text box.
	Setup

	A.8.12
	Click Export.
	A Confirmation window appears asking: Export this directory permanently?
	Setup

	A.8.13
	Click YES.
	The Confirmation window disappears and control returns to the Disk Manager window.
	Setup

	A.8.14
	Select the row that contains the /home2 partition in the Mounted On column.
	The row is highlighted.
	Setup



	A.8.15
	Click Export FS.
	The Export/Unexport File Systems window appears.
	Setup

	A.8.16
	In the options text box, type:

ro,root=kpccp
	ro,root=kpccp appears in the text box.
	Setup



	A.8.17
	In the pathname text box, verify /home2 is present.
	/home2 appears in the pathname text box.
	Setup

	A.8.18
	Click Export.
	A Confirmation window appears asking: Export this directory permanently?
	Setup

	A.8.19
	Click Yes.
	The Confirmation window disappears and control returns to the Disk Manager window.
	Setup

	A.8.20
	In the Terminal window, at the command prompt type

share
	The following text is displayed:

/kpc ro=kpccp
/cdrom/kpc_4204 ro=kpccp
/home2 ro,root=kpccp
	Setup

	A.9
	Setup – Mount /h/data/global Directory From the Candidate Platform (kpccp) On the Validation Host (kpchost)
	

	A.9.1
	NOTE: Perform the following steps on the Validation Host (kpchost).

In the Disk Manager window, click Mount New.
	The Mount File System window appears.
	Setup



	A.9.2
	In the File System text box, type

kpccp:/h/data/global
	kpccp:/h/data/global appears in the text box.
	Setup

	A.9.3
	In the Mount Point text box, type

/h/data/global
	/h/data/global appears in the text box.
	Setup

	A.9.4
	Click Mount.
	A Confirmation window asks:  

Mount the File System Permanently?
	Setup

	A.9.5
	Click  YES.
	The Confirmation window disappears and control returns to the Disk Manager window. kpccp:/h/data/global appears as a file system.
	Setup

	A.9.6
	Click  Exit.
	The Disk Manager window disappears.
	Setup



	A.10
	Setup – Mount /kpc and /cdrom/kpc_4204 Directories From the Validation Host (kpchost) On the Candidate Platform (kpccp)
	

	A.10.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Disk Manager window, click Mount New.
	The Mount File System window appears.
	Setup



	A.10.2
	In the File System text box, type 

kpchost:/kpc
	kpchost:/kpc appears in the text box.
	Setup

	A.10.3
	In the Mount Point text box, type

/kpchostdsk
	/kpchostdsk appears in the text box.
	Setup

	A.10.4
	Click Mount.
	A Confirmation window asks: 

 Mount the File System Permanently?
	Setup

	A.10.5
	Click YES.
	The Confirmation window disappears and control returns to the Disk Manager window. kpchost:/kpc appears as a file system. 
	Setup

	A.10.6
	Click Mount New.
	The Mount File System window appears.
	Setup



	A.10.7
	In the File System text box, type 

kpchost:/cdrom/kpc_4204
	kpchost:/cdrom/kpc_4204 appears in the text box.
	Setup

	A.10.8
	In the Mount Point text box, type

/kpchostcdrom
	/kpchostcdrom appears in the text box.
	Setup

	A.10.9
	Click Mount.
	A Confirmation window asks:  

Mount the File System Permanently?
	Setup

	A.10.10
	Click YES.
	The Confirmation window disappears and control returns to the Disk Manager window. kpchost:/cdrom/kpc_4204 appears as a file system.
	Setup

	A.10.11
	Click Exit. 
	The Disk Manager window disappears.
	Setup



	A.11
	Setup – Eject the CD-ROM On the Validation Host (kpchost)
	

	A.11.1
	NOTE: Perform the following steps on the Validation Host (kpchost).

In the Terminal window, at the command prompt, type 
unshare /cdrom/kpc_4204
	The command prompt returns.
	Setup



	A.11.2
	At the command prompt type

share 
	The following text is displayed:

/kpc ro=kpccp

/home2 ro,root=kpccp
	Setup



	A.11.3
	At the command prompt type 

eject
	The CD-ROM is ejected.
	Setup



	B
	Verify Segment Installer Feature Availability

	B.1
	Segment Installer - Main Window On the Candidate Platform (kpccp) and the Validation Host (kpchost)
	

	B.1.1
	NOTE: Perform the following steps on the Validation Host (kpchost) and Candidate Platform (kpccp).

In the Application Manager – SysAdm window, double-click Segment Installer.
	The Installer window appears.
	Circle one:  PASS / FAIL



	B.1.2
	Verify the Installer windows on each platform are similar.
	Size, shape, color and textual information on the Candidate Platform is similar to the Validation Host.  
	Circle one:  PASS / FAIL



	B.1.3
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Verify at the top of the screen, the following pull-down menus and their contents:
File
Source
Installed 
Contents 
Help (Grayed Out)

NOTE:  Each of these Menu Items / Functions are duplicates of buttons on the main screen and either choice produces the same results.
	The menu items are present and contain:

File –      Install
            Exit 

Source -    Select Source
            Read Contents

Installed – Release Notes
            Deinstall Software
            View Installation Log

Contents -  Release Notes
            Required Software
            Conflicting Software

Help -      (No Action)
	Circle one:  PASS / FAIL



	B.1.4
	Resize the Installer window.
	The Installer window resizes both larger and smaller. 
	Circle one:  PASS / FAIL



	B.1.5
	Minimize the Installer window by clicking the dot in the right corner of the title bar.
	The Installer window iconifies to the top left corner of the screen.
	Circle one:  PASS / FAIL



	B.1.6
	Restore the Installer window by double-clicking on the Installer icon.
	The Installer window restores to its previous  state.
	Circle one:  PASS / FAIL



	B.1.7
	Relocate the Installer window.
	The Installer window relocates anywhere on the screen.
	Circle one:  PASS / FAIL



	B.1.8
	Double-click the upper left corner of the Installer window.
	The Installer window disappears.
	Circle one:  PASS / FAIL



	B.1.9
	In the Application Manager – SysAdm window, double-click Segment Installer. 
	The Installer window appears.
	Circle one:  PASS / FAIL



	B.2
	Source Area - Verify Buttons and Fields Are Present On the Candidate Platform (kpccp)
	

	B.2.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Verify the following Source fields are present:

Host:
Device:
	All fields are present.
	Circle one:  PASS / FAIL



	B.2.2
	Verify the following buttons are present:

Select Source
Read Contents
	All buttons are present.
	Circle one:  PASS / FAIL



	B.2.3
	Verify the information displayed in the Source field is correct:

Host:  LOCAL  kpccp
Device: DAT 
	The display reflects the current configuration.
	Circle one:  PASS / FAIL



	B.3
	Select Source - Verify the Functionality of the Select Source Window; Select  Each Option On the Candidate Platform (kpccp)
	

	B.3.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Source field, click Select Source.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	B.3.2
	Verify the following radio buttons are present:

Host:                       Device:
LOCAL         DISK      CD-ROM
REMOTE        DAT       EXABYTE
              NETWORK   OTHER
	All radio buttons are present and LOCAL  and DAT are selected.

NOTE: Only certain combinations work.

LOCAL - ALL  (NETWORK doesn’t care)

REMOTE – DAT, EXABYTE, OTHER 

NOTE:  DISK and CD-ROM are accessible from a remote device if shared and mounted.
	Circle one:  PASS / FAIL



	B.3.3
	In the Host field, verify LOCAL is selected. 

	LOCAL is selected.
	Circle one:  PASS / FAIL



	B.3.4
	In the Device field , select DISK.


	The Select File window appears.
	Circle one:  PASS / FAIL



	B.3.5
	Verify the existence of the following four sections:

Filter
Directories
Files
Selection
	Each of these sections is present.  The filtering section at the top can be used to find a particular file.
	Circle one:  PASS / FAIL



	B.3.6
	Verify the existence of four buttons at the bottom of the Select File window:

OK, Filter, Cancel, Help
	All buttons are present.
	Circle one:  PASS / FAIL



	B.3.7
	Click Cancel.
	The Select File window disappears.
	Circle one:  PASS / FAIL



	B.3.8
	Click OK.
	The Select Source window disappears and the Installer window reappears.
	Circle one:  PASS / FAIL



	B.3.9
	Verify the information presented in the following fields is correct:

Host:  LOCAL  kpccp
Device: DISK
	The display reflects the tester’s selections.
	Circle one:  PASS / FAIL



	B.3.10
	In the Source field, click Select Source.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	B.3.11
	In the Host field, verify LOCAL is selected.


	LOCAL is selected.


	Circle one:  PASS / FAIL



	B.3.12
	In the Device field, select CD-ROM.
	The Select File window appears.
	Circle one:  PASS / FAIL



	B.3.13
	Verify the existence of the following four sections:

Filter
Directories
Files
Selection
	Each of these sections is present.  The filtering section at the top can be used to find a particular file.
	Circle one:  PASS / FAIL



	B.3.14
	Verify the existence of four buttons at the bottom of the Select File window:

OK, Filter, Cancel, Help
	All buttons are present.


	Circle one:  PASS / FAIL



	B.3.15
	Click Cancel.
	The Select File window disappears.
	Circle one:  PASS / FAIL



	B.3.16
	In the Device field, select EXABYTE.
	EXABYTE is selected.
	Circle one:  PASS / FAIL



	B.3.17
	In the Device field, select OTHER.
	A text box appears for manually entering a device.
	Circle one:  PASS / FAIL



	B.3.18
	Enter the device path in the text box, e.g., /dev/rmt/0mn.
	The device path appears in the text box.
	Circle one:  PASS / FAIL



	B.3.19
	Click OK.
	The Installer window appears and the Source field displays: 

Host:  LOCAL kpccp
Device: <device path>
where <device path> is the device file entered in the previous step, e.g., /dev/rmt/0mn
	Circle one:  PASS / FAIL



	B.3.20
	In the Source field, click Select Source.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	B.3.21
	In the Device field, click DAT.
	DAT is selected.
	Circle one:  PASS / FAIL



	B.3.22
	Click OK.
	The Installer window appears and the Source field displays: 

Host:  LOCAL  kpccp
Device: DAT
	Circle one:  PASS / FAIL



	B.4
	Available Disks Field Display On the Candidate Platform (kpccp)
	

	B.4.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Verify the Available Disks field displays the following columns:

Disk   Actual   Available   Selected   Reserved

Verify the button Reserved Space appears (grayed out).
	  Disk      Actual    Available    Selected    Reserved

  /h
  /home1   8.56MB    6.85MB     0.0 MB    1.71MB
  /home2

                                          [ Reserved Space ]

NOTE: These values are approximate values and may vary slightly depending on the disk configuration.
	Circle one:  PASS / FAIL



	B.5
	Available Disks  - Reserved Space  -  Override Disk Space Allocation Window On the Candidate Platform (kpccp)
	

	B.5.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Select partition /home1 from the Available Disks field.
	/home1 is highlighted.


	Circle one:  PASS / FAIL



	B.5.2
	In the Available Disks field, click Reserved Space. 
	An Override Disk Space Allocation window appears.
	Circle one:  PASS / FAIL



	B.5.3
	Verify the default value of Override Disk Space Limits.


	The default value is set to 80%.


	Circle one:  PASS / FAIL



	B.5.4
	Click on the Override Disk Space Limits button to show the pull-down menu.


	The Override Disk Space Limits are:

80%
(selected by default)
90%
95%
99%
	Circle one:  PASS / FAIL



	B.5.5
	Select 90%.
	The Override Disk Space Limits selection changes to 90%. 

	Circle one:  PASS / FAIL



	B.5.6
	Verify the Clear and Set to Default box is not selected.


	The Clear and Set to Default box is not selected.


	Circle one:  PASS / FAIL



	B.5.7
	Select and deselect the Clear and Set to Default box.


	The box toggles on and off.
	Circle one:  PASS / FAIL



	B.5.8
	Click Cancel.
	The Override Disk Space Allocation window disappears and the Disk values remain unchanged.
	Circle one:  PASS / FAIL



	B.5.9
	In the Available Disks field, click Reserved Space. 
	The Override Disk Space Allocation window appears.
	Circle one:  PASS / FAIL



	B.5.10
	Click on the Override Disk Space Limits button to show the pull-down menu.


	The Override Disk Space Limits pull-down menu appears.


	Circle one:  PASS / FAIL



	B.5.11
	Select 99%.


	The Override Disk Space Limits selection changes to 99%. 

	Circle one:  PASS / FAIL



	B.5.12
	Click OK.
	The Available Disks field displays the following approximate values:
   Disk      Actual    Available    Selected    Reserved

  /home1   8.56MB    8.48MB     0.0 MB    0.09MB

NOTE: These values are approximate values and may vary slightly depending on the disk configuration.
	Circle one:  PASS / FAIL



	B.5.13
	In the Available Disks field, click Reserved Space. 
	The Override Disk Space Allocation window appears.
	Circle one:  PASS / FAIL



	B.5.14
	Verify the Override Disk Space Limits selection is returned to 80%.  
	The Override Disk Space Limits selection is returned to 80%.
	Circle one:  PASS / FAIL



	B.5.15
	Click OK.
	The Available Disks field displays the following approximate values:
  Disk      Actual    Available    Selected    Reserved

  /home1   8.56MB    6.80MB     0.0 MB    1.71MB

NOTE: These values are approximate values and may vary slightly depending on the disk configuration.
	Circle one:  PASS / FAIL



	B.6
	Available Disks  -  Verify the Information Presented for Actual Disk Size Is Correct On the Candidate Platform (kpccp)
	

	B.6.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Terminal window, at the command prompt type

df -k
	The /home1 disk space information is listed as follows:

Kbytes   used    available     Mounted on

 9751        61        8715           /home1

NOTE: These values are approximate values and may vary slightly depending on the disk configuration.
	Circle one:  PASS / FAIL



	B.6.2
	To verify the disk space values shown in the Available Disks field, /home1, perform the following calculations:

Actual = avail(df -k) / 1024

Reserved = kbytes(df -k) * .9 * .2 / 1024

Available = Actual - Reserved
	Results are within 10 K of the values listed in the Available Disks field.  The values listed in the Installer window concur.

Actual     = 8.56MB

Reserved = 1.71MB

Available = 8.56 – 1.71 = 6.80MB
	Circle one:  PASS / FAIL

Actual:___________

Reserved:_________

Available:_________



	B.6.3
	In the Installer window, select /home1 in the Available Disks field.

 
	/home1 is highlighted.


	Circle one:  PASS / FAIL



	B.6.4
	In the Source field, click Select Source.


	The Select Source window appears.
	Circle one:  PASS / FAIL



	B.6.5
	In the Device field, select DISK. 
	The Select File window appears.
	Circle one:  PASS / FAIL



	B.6.6
	In the Filter text box type 

/kpc/si/* [r]
	/kpc/si/* appears in the text box.
	Circle one:  PASS / FAIL



	B.6.7
	In the Files field, double-click bigseg.tar.
	The Select File window disappears and the Installer window reappears.
	Circle one:  PASS / FAIL



	B.6.8
	Click Read Contents.
	The Installer window returns with Big Test Segment appearing in the Select Software To Install field.
	Circle one:  PASS / FAIL



	B.6.9
	Select Big Test Segment in the Select Software To Install field.
	Big Test Segment is highlighted and the Disk column in the Select Software To Install field displays /home1.  If it doesn’t, deselect the segment and reselect it. The Selected column in the Available Disks field changes from 0.00MB to 0.10MB.
	Circle one:  PASS / FAIL



	B.6.10
	At the bottom of the Installer window, click Install.
	An ENTER A PASSWORD dialog box appears asking for the Master APM Authentication key.
	Circle one:  PASS / FAIL



	B.6.11
	Enter the Master APM Authentication key in the text box.
	Asterisks appear in the text box.
	Circle one:  PASS / FAIL



	B.6.12
	Click OK.
	Big Test Segment installs correctly and is preceded by an * in the Select Software To Install field. Big Test Segment appears in the Currently Installed Segments field.
	Circle one:  PASS / FAIL



	B.6.13
	In the Available Disks field, verify the /home1 partition values have changed.
	 The Available Disks field displays the following approximate values:
 Disk      Actual      Available    Selected    Reserved

/home1   8.46MB    6.70MB      0.0 MB    1.71MB
NOTE: These values are approximate values and may vary slightly depending on the disk configuration.

NOTE: See Known Problems 1 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	B.6.14
	In the Currently Installed Segments field, select Big Test Segment.
	Big Test Segment is highlighted.
	Circle one:  PASS / FAIL



	B.6.15
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box appears with the message: 

Do you really want to remove the segments?

Big Test Segment 
	Circle one:  PASS / FAIL



	B.6.16
	Click Yes.
	Big Test Segment deinstalls correctly and is no longer preceded by an * in the Select Software To Install field. Big Test Segment no longer appears in the Currently Installed Segments field.
	Circle one:  PASS / FAIL



	B.7
	Available Disks - Reserve Space 99% – Verify Segment Installation On the Candidate Platform (kpccp)
	

	B.7.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp). 

In the  Terminal window, at the command prompt type
cd /home1
	The command prompt returns.
	Setup



	B.7.2
	At the command prompt type
mkfile 4m fillspace

NOTE: This method is OS specific. Use the relevant method on the OS being tested and note it in the Observed Result column.
	The command prompt returns.
	Setup



	B.7.3
	In the Available Disks field select /home1.
	/home1 is highlighted.
	Circle one:  PASS / FAIL



	B.7.4
	In the Available Disks field, click Reserved Space.
	The Override Disk Space Allocation window appears.
	Circle one:  PASS / FAIL



	B.7.5
	Change the Override Disk Space Limits value from 80% to 99%.  
	The 99% toggle is selected.
	Circle one:  PASS / FAIL



	B.7.6
	Click OK.


	 The Available Disks field displays the following approximate values:
Disk       Actual    Available    Selected    Reserved

 /home1   4.55MB   4.47MB     0.0 MB    0.09MB

NOTE: These values are approximate values and may vary slightly depending on the disk configuration. 

NOTE: See Known Problems 1 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	B.7.7
	In the Select Software To Install field, select Big Test Segment.
	Big Test Segment is highlighted and the Disk column in the Select Software To Install field displays /home1.  If it doesn’t, deselect the segment and reselect it. The Selected field in the Available Disks field changes from 0.0MB to 0.10MB.
	Circle one:  PASS / FAIL



	B.7.8
	At the bottom of the Installer window, select Install.


	Big Test Segment installs correctly and is preceded by an * in the Select Software To Install field. Big Test Segment appears in the Currently Installed Segments field.
	Circle one:  PASS / FAIL



	B.7.9
	In the Available Disks field verify the  /home1 partition values have changed.
	 The Available Disks field displays the following approximate values:
 Disk       Actual      Available    Selected   Reserved

 /home1   4.45MB     2.79MB      0.0 MB    1.71MB
NOTE: These values are approximate values and may vary slightly depending on the disk configuration. 

NOTE: See Known Problems 1 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	B.7.10
	In the Currently Installed Segments window select Big Test Segment.
	Big Test Segment is highlighted.
	Circle one:  PASS / FAIL



	B.7.11
	Click Deinstall Software.


	A Respond to the Question dialog box appears with the message: 

Do you really want to remove the segments?

Big Test Segment?
	Circle one:  PASS / FAIL



	B.7.12
	Click Yes.
	Big Test Segment deinstalls correctly and is no longer preceded by an * in the Select Software To Install field. Big Test Segment no longer appears in the Currently Installed Segments field.
	Circle one:  PASS / FAIL



	B.8
	Available Disks - No Space – Verify Segment Installation Roll Over on the Candidate Platform (kpccp)
	

	B.8.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Available Disks field select /home1.
	/home1 is highlighted.
	Circle one:  PASS / FAIL



	B.8.2
	In the Available Disks field click Reserved Space.
	The Override Disk Space Allocation window appears.
	Circle one:  PASS / FAIL



	B.8.3
	Click OK.  
	 The Available Disks field displays the 

 following approximate values:
   Disk      Actual    Available    Selected    Reserved

 /home1   4.55MB    2.84MB     0.0 MB    1.71MB

NOTE: These values are approximate values and may vary slightly depending on the disk configuration. 

NOTE: See Known Problems 1 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	B.8.4
	Select Big Test Segment in the Select Software To Install field.
	Big Test Segment is highlighted and the Disk column in the Select Software To Install field displays /home1.  If it doesn’t, deselect the segment and reselect it.  

A Warning window appears stating that available disk space is not enough and the disk will be switched to next available disk.
	Circle one:  PASS / FAIL



	B.8.5
	Click OK in the Warning window.

	The Warning window disappears.
	Circle one:  PASS / FAIL



	B.8.6
	At the bottom of the Installer window click Install.


	Big Test Segment installs correctly and is preceded by an * in the Select Software To Install field. Big Test Segment appears in the Currently Installed Segments window.


	Circle one:  PASS / FAIL



	B.8.7
	In the Available Disks field verify /home1 values have remained the same and the segment installed on /h (or the first available disk partition).
	 The Available Disks field displays the following approximate values:
 Disk      Actual    Available    Selected    Reserved

 /home1   4.45MB    2.79MB    0.00 MB    1.71MB
NOTE: These values are approximate values and may vary slightly depending on the disk configuration. 

NOTE: See Known Problems 1 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	B.8.8
	In the Currently Installed Segments window select Big Test Segment.
	Big Test Segment is highlighted.
	Circle one:  PASS / FAIL

 

	B.8.9
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box appears with the message: 

Do you really want to remove the segments?

Big Test Segment?
	Circle one:  PASS / FAIL



	B.8.10
	Click Yes.
	Big Test Segment deinstalls correctly.
	Circle one:  PASS / FAIL



	B.8.11
	Click Exit.
	The Installer window disappears.
	Circle one:  PASS / FAIL



	B.9
	Available Disks - No Space – Verify Segment Installation Failure On the Candidate Platform (kpccp)
	

	B.9.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Terminal window at the command prompt type  

cd / 
	The command prompt returns.
	Setup



	B.9.2
	At the command prompt type

mv /home2 /newhome2 
	The command prompt returns.
	Setup



	B.9.3
	At the command prompt type

mkfile 950m /h/fillspace

NOTE: This method is OS specific. Use the relevant method on the OS being tested and note it in the Observed Result column.

NOTE: The file size parameter may vary, depending on the size of the /h partition. Create a file large enough to fill the /h partition up to at least 85%.
	NOTE: The command may take a few moments to complete.

The command prompt returns.
	Setup



	B.9.4
	In the Application Manager – SysAdm window, double-click Segment Installer.
	The Installer window appears.
	Circle one:  PASS / FAIL



	B.9.5
	Click Select Source in the Source field.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	B.9.6
	In the Device field, click DISK.


	The Select File window appears.
	Circle one:  PASS / FAIL



	B.9.7
	In the Filter text box type 

/kpc/si/* [r]
	/kpc/si/* appears in the text box.
	Circle one:  PASS / FAIL



	B.9.8
	In the Files field, double-click bigseg.tar
	The Installer window reappears.
	Circle one:  PASS / FAIL



	B.9.9
	In the Available Disks field, select /home1.
	/home1 is highlighted.
	Circle one:  PASS / FAIL



	B.9.10
	In the Source field click Read Contents.
	The Installer window reappears with Big Test Segment under the Select Software To Install field.
	Circle one:  PASS / FAIL



	B.9.11
	Select Big Test Segment in the Select Software to Install field.
	A Warning window appears stating that available disk space is not enough. You may increase the available disk space using the Reserved Space Override.
	Circle one:  PASS / FAIL



	B.9.12
	Click OK.
	The Warning window disappears. 

Control returns to the Installer window.
	Circle one:  PASS / FAIL



	B.9.13
	In the Terminal window, at the command prompt type 

cd /
	The command prompt returns.
	Cleanup

	B.9.14
	At the command prompt type

mv /newhome2 /home2
	The command prompt returns.
	Cleanup

	B.9.15
	At the command prompt type
rm /h/fillspace /home1/fillspace
	The command prompt returns.
	Cleanup

	C
	Local Devices Testing

	C.1
	Verify Segment Installer  Can Read Table Of Contents and Install Segments From A Local Tape Drive (DAT) On the Candidate Platform (kpccp)
	

	C.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Installer window, click Select Source in the Source field.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	C.1.2
	In the Host field, verify LOCAL is selected.
	LOCAL is selected.
	Circle one:  PASS / FAIL



	C.1.3
	In the Device field, select DAT.
	DAT is selected.


	Circle one:  PASS / FAIL



	C.1.4
	Select OK.
	The Installer window reappears and the Source field displays: 

Host:  LOCAL  kpccp
Device: DAT
	Circle one:  PASS / FAIL



	C.1.5
	Insert the Test Segment segx tape into the local device.

Note: Refer to Step ZZ. Appendix A for instructions on creating the segx tape.
	The tape drive initializes properly.
	Circle one:  PASS / FAIL



	C.1.6
	In the Source field, click Read Contents.
	The Installer reads the Table of Contents.  When complete, the Installer displays Test Segment segx in the Select Software To Install field.
	Circle one:  PASS / FAIL



	C.1.7
	In the Available Disks field, select /h.
	/h is highlighted.
	Circle one:  PASS / FAIL



	C.1.8
	Select Test Segment segx.
	Test Segment segx is highlighted and the Disk column in the Select Software To Install field displays /h.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	C.1.9
	Click Install.
	The Segment Installer prompts for the master APM authentication key.
	Circle one:  PASS / FAIL



	C.1.10
	Enter the master APM authentication key in the field provided.
	Asterisks appear in the text box.
	Circle one:  PASS / FAIL



	C.1.11
	Click OK.
	Test Segment segx installs accordingly under /h. Once installed, it appears under the Select Software To Install field marked by an asterisk and is listed under the Currently Installed Segments field.
	Circle one:  PASS / FAIL



	C.2
	Verify Segment Installs and Deinstalls Correctly On the Candidate Platform (kpccp)
	

	C.2.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

On the Installer menu bar, select Installed > View Installation Log.
	The Install Log window appears.
	Circle one:  PASS / FAIL



	C.2.2
	Verify the segment installed correctly.
	The Install Log indicates: 

Segment (Test Segment segx) successfully installed.
	Circle one:  PASS / FAIL



	C.2.3
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	C.2.4
	In the Terminal window, at the command prompt, type 

ls /h/segx 
	The contents of the directory is listed with Integ, Scripts, SegDescrip, bin, and data subdirectories.
	Circle one:  PASS / FAIL



	C.2.5
	In the Installer window, verify Test Segment segx is listed under Currently Installed Segments.
	Test Segment segx is listed.
	Circle one:  PASS / FAIL



	C.2.6
	Under Currently Installed Segments select Test Segment segx.
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	C.2.7
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Test Segment segx
	Circle one:  PASS / FAIL



	C.2.8
	Click Yes.
	Test Segment segx deinstalls correctly and is no longer preceded by an * in the Select Software To Install field.  Test Segment segx no longer appears in the Currently Installed Segments field.
	Circle one:  PASS / FAIL



	C.2.9
	On the Installer menu bar, select Installed > View Installation Log.
	The Install Log window indicates: 

Segment (Test Segment segx) successfully de-installed.
	Circle one:  PASS / FAIL



	C.2.10
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	C.3
	Verify Window Name and Functionality Of Currently Installed Release Notes On the Candidate Platform (kpccp)
	

	C.3.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Select Release Notes below Select Software To Install.

(currently grayed out).
	The Release Notes window does not open.
	Circle one:  PASS / FAIL



	C.3.2
	Select Test Segment segx from the Select Software To Install field.  
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	C.3.3
	Click Release Notes.
	The RELEASE NOTES window appears with the following header fields:

Name:
Test Segment segx

Version:
1.2.3.4

This segment is used when testing Segment Installer.
	Circle one:  PASS / FAIL



	C.3.4
	 Click OK.
	The RELEASE NOTES window disappears.
	Circle one:  PASS / FAIL



	C.3.5
	In the Select Software To Install field, click Requires.
	The REQUIRED SEGMENTS window appears with the following header fields:

Name:
Test Segment segx

Version:
1.2.3.4

 Name                     Version

COE Component Parent      4.0.0.0
	Circle one:  PASS / FAIL



	C.3.6
	 Click OK.
	The REQUIRED SEGMENTS window disappears.
	Circle one:  PASS / FAIL



	C.3.7
	In the Select Software To Install field, click Conflicts.
	The CONFLICTING SEGMENTS window appears with the following header fields:

Name:
Test Segment segx

Version:
1.2.3.4

Name                     Version Dummy Conflict Segment    (blank)
	Circle one:  PASS / FAIL



	C.3.8
	 Click OK.
	The CONFLICTING SEGMENTS window disappears.
	Circle one:  PASS / FAIL



	C.4
	Install A Segment To An Alternate Location  On the Candidate Platform (kpccp)
	

	C.4.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Available Disks field, select  /home1.
	/home1 is highlighted.
	Circle one:  PASS / FAIL



	C.4.2
	In the Select Software to Install field, select Test Segment segx.
	The disk listed under the Disk  column changes to /home1 under Select Software To Install.
	Circle one:  PASS / FAIL



	C.4.3
	Click Install.
	Test Segment segx installs accordingly under /home1.  Once installed, it appears under Select Software To Install marked by an asterisk and is listed under Currently Installed Segments.
	Circle one:  PASS / FAIL



	C.5
	Verify Successful Installation Of Test Segment segx On the Alternate Location On the Candidate Platform (kpccp)
	

	C.5.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Terminal window, at the command prompt  type

ls -la /home1
	The contents of the directory /home1 is listed with segx as a subdirectory.
	Circle one:  PASS / FAIL



	C.5.2
	Type 

ls -la /h 

and verify that the softlink segx (( /home1/segx is listed.
	The softlink segx (( /home1/segx is listed.
	Circle one:  PASS / FAIL



	C.5.3
	In the Installer window select Test Segment segx in the Currently Installed Segments field.
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	C.5.4
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Test Segment segx
	Circle one:  PASS / FAIL



	C.5.5
	Click Yes.
	Test Segment segx deinstalls correctly and is no longer preceded by an * in the Select Software To Install field.  Test Segment segx no longer appears in the Currently Installed Segments field.
	Circle one:  PASS / FAIL



	C.6
	Verify Segment Installer Can Read Table Of Contents and Install Segments From A Local CD-ROM Drive On the Candidate Platform (kpccp)
	

	C.6.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Insert the KPC Test Data CD-ROM into the CD-ROM drive.
	The CD-ROM is inserted.
	Circle one:  PASS / FAIL



	C.6.2
	In the Installer window, click Select Source in the Source field.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	C.6.3
	In the Device field, select CD-ROM. 
	The Select File window appears.
	Circle one:  PASS / FAIL



	C.6.4
	Enter the following in the Selection text box:

/cdrom/kpc_4204/segx.tar
	/cdrom/kpc_4204/segx.tar appears in the text box.
	Circle one:  PASS / FAIL



	C.6.5
	Click OK.
	The Installer window reappears.
	Circle one:  PASS / FAIL



	C.6.6
	In the Source field, click Read Contents.
	The Installer reads the Table of Contents.  When complete, the Installer displays the Select Software To Install field. 
	Circle one:  PASS / FAIL



	C.6.7
	In the Available Disks field, verify /home1 is selected.
	/home1 is highlighted.
	Circle one:  PASS / FAIL



	C.6.8
	In the Select Software To Install field, select Test Segment segx.
	Test Segment segx is highlighted and the Disk column in the Select Software To Install field displays /home1.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	C.6.9
	Click Install.
	The following message appears:

Please Insert CD Volume #1 for the segment ‘Test Segment segx’.
When you are ready press the OK button.
	Circle one:  PASS / FAIL



	C.6.10
	Click OK.
	Test Segment segx installs accordingly under /home1. Once installed, it appears under Select Software To Install marked by an asterisk and is listed under Currently Installed Segments.
	Circle one:  PASS / FAIL



	C.7
	Verify Segment Installs and Deinstalls Correctly On the Candidate Platform (kpccp)
	

	C.7.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

On the Installer menu bar, select Installed > View Installation Log.
	The Install Log window appears.
	Circle one:  PASS / FAIL



	C.7.2
	Verify the segment installed correctly.
	The Install Log indicates: 

Segment (Test Segment segx) successfully installed.
	Circle one:  PASS / FAIL



	C.7.3
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	C.7.4
	At the command prompt type

ls –la /home1/segx
	The directory segx is listed with Integ, Scripts, SegDescrip, bin, and data subdirectories.
	Circle one:  PASS / FAIL



	C.7.5
	In the Installer window, verify Test Segment segx is listed under Currently Installed Segments.
	The segment is listed.
	Circle one:  PASS / FAIL



	C.7.6
	In the Currently Installed Segments field, select Test Segment segx.
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	C.7.7
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Test Segment segx
	Circle one:  PASS / FAIL



	C.7.8
	Click Yes.
	The segment deinstalls and is not listed under Currently Installed Segments.
	Circle one:  PASS / FAIL



	C.7.9
	On the Installer menu bar, select Installed > View Installation Log.
	The Install Log window indicates: 

Segment Test Segment segx) successfully de-installed.
	Circle one:  PASS / FAIL



	C.7.10
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	C.7.11
	At the command prompt type 

eject
	The CD-ROM is ejected.
	Circle one:  PASS / FAIL

	C.8
	Verify Segment Installer Can Read Table Of Contents and Install Segments From A Local Other Device On the Candidate Platform (kpccp)
	

	C.8.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Installer window, click Select Source in the Source field.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	C.8.2
	In the Device field, click OTHER.
	OTHER is selected.

A text box appears for manually entering a device path.
	Circle one:  PASS / FAIL



	C.8.3
	In the OTHER text box, enter the device path of the local tape drive: e.g. /dev/rmt/0mn
	The text box accepts user input.
	Circle one:  PASS / FAIL



	C.8.4
	Click OK.
	The Installer window reappears with correct information in the Source field.
	Circle one:  PASS / FAIL



	C.8.5
	Ensure the segx test tape is loaded in the local tape drive.
	The tape is loaded.
	Setup



	C.8.6
	In the Source field, click Read Contents.
	The Installer reads the Table of Contents.  When complete, The Installer displays the Select Software To Install field.
	Circle one:  PASS / FAIL



	C.8.7
	In the Select Software To Install field, select Test Segment segx. 
	Test Segment segx is highlighted and the Disk column in the Select Software To Install field displays /home1.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	C.8.8
	Click Install.
	Test Segment segx installs accordingly under /home1.  Once installed, it appears under Select Software To Install marked by an asterisk and is listed under Currently Installed Segments field.
	Circle one:  PASS / FAIL



	C.9
	Verify Segment Installs and Deinstalls Correctly On the Candidate Platform (kpccp)
	

	C.9.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

On the Installer menu bar, select Installed > View Installation Log.
	The Install Log window appears.
	Circle one:  PASS / FAIL



	C.9.2
	Verify the segment installed correctly.
	The Install Log indicates: 

Segment (Test Segment segx) successfully installed.
	Circle one:  PASS / FAIL



	C.9.3
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	C.9.4
	At the command prompt type

ls –la /home1/segx
	The directory segx is listed with Integ, Scripts, SegDescrip, bin, and data subdirectories.
	Circle one:  PASS / FAIL



	C.9.5
	In the Installer window, verify Test Segment segx is listed under Currently Installed Segments.
	Test Segment segx is listed.
	Circle one:  PASS / FAIL



	C.9.6
	In the Currently Installed Segments field, select Test Segment segx.
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	C.9.7
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Test Segment segx
	Circle one:  PASS / FAIL



	C.9.8
	Click Yes.
	The segment deinstalls and is not listed under Currently Installed Segments.
	Circle one:  PASS / FAIL



	C.9.9
	On the Installer menu bar, select Installed > View Installation Log.
	The Install Log window indicates: 

Segment (Test Segment segx) successfully de-installed.
	Circle one:  PASS / FAIL



	C.9.10
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	C.9.11
	At the command prompt type 

mt rewoffl 


	The tape is ejected.
	Setup

	C.10
	Verify Segments Can Be Read and Install Segments From A Local Tape Drive 

(Select Source  -  EXABYTE)  Optional test if vendor supports Exabyte drives
	

	D
	Remote Device Testing

	D.1
	Verify Segments Can Be Read, Installed and De-installed From A Remote Tape Device  (DAT) On the Candidate Platform (kpccp)
	

	D.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Installer window, click Select Source in the Source field. 
	The Select Source window appears.
	Circle one:  PASS / FAIL



	D.1.2
	In the Host field, select REMOTE.
	REMOTE is selected and a NAME text box appears.
	Circle one:  PASS / FAIL



	D.1.3
	Type kpchost in the NAME text box.
	kpchost appears in the NAME text box.


	Circle one:  PASS / FAIL



	D.1.4
	In the Device field, select DAT.
	DAT is selected.
	Circle one:  PASS / FAIL



	D.1.5
	Click OK.
	The Select Source window disappears. In the Source window of the Installer, the Host: entry says REMOTE and the correct machine name.  Also the Device: entry selects the tape device you are using.
	Circle one:  PASS / FAIL



	D.1.6
	Insert the Test Segment segx tape into kpchost’s tape drive. 
	The tape drive initializes properly.
	Circle one:  PASS / FAIL



	D.1.7
	In the Source field, click Read Contents.
	The Installer reads the Table of Contents.  When complete, The Installer displays the Select Software To Install field.
	Circle one:  PASS / FAIL



	D.1.8
	In the Select Software To Install window, select Test Segment segx.


	Test Segment segx is highlighted and the Disk column in the Select Software To Install field displays /home1.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	D.1.9
	Click Install.
	The segment installs under /home1.


	Circle one:  PASS / FAIL



	D.1.10
	In the Currently Installed Segments field, select Test Segment segx.
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	D.1.11
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Test Segment segx
	Circle one:  PASS / FAIL



	D.1.12
	Click Yes.
	The segment deinstalls and is not listed under Currently Installed Segments.
	Circle one:  PASS / FAIL



	D.2
	Verify Segments Can Be Read, Installed and De-installed From A Remote OTHER Device On the Candidate Platform (kpccp) 
	

	D.2.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Installer window, click Select Source, in the Source field.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	D.2.2
	In the Host field verify that REMOTE is selected.
	REMOTE is selected.
	Circle one:  PASS / FAIL



	D.2.3
	In the Device field, click OTHER.
	A text box appears to the right of the OTHER device selection.
	Circle one:  PASS / FAIL



	D.2.4
	In the OTHER text box, enter the appropriate device path for the remote tape drive, e.g., /dev/rmt/0mn.
	/dev/rmt/0mn appears in the text box.
	Circle one:  PASS / FAIL



	D.2.5
	Click OK.
	The Select Source window disappears. In the Source window of the Installer, the Host: entry says REMOTE and the correct machine name.  Also the Device: entry displays the other device path.
	Circle one:  PASS / FAIL



	D.2.6
	Ensure the segx test tape is loaded in the local tape drive.
	The tape is loaded.
	Setup



	D.2.7
	Under Source, Click Read Contents.
	The Installer window returns with a Select Software To Install field.
	Circle one:  PASS / FAIL



	D.2.8
	Select Test Segment segx.


	Test Segment segx is highlighted and the Disk column in the Select Software To Install field displays /home1.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	D.2.9
	Click Install.
	The segment installs under /home1.
	Circle one:  PASS / FAIL



	D.2.10
	In the Currently Installed Segments field, select Test Segment segx.
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	D.2.11
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Test Segment segx
	Circle one:  PASS / FAIL



	D.2.12
	Click Yes.
	The segment deinstalls and is not listed under Currently Installed Segments.
	Circle one:  PASS / FAIL



	D.2.13
	NOTE: Perform the following step on the Validation Host (kpchost).

At the command prompt type 

mt rewoffl 


	The tape is ejected.
	Setup

	D.3
	Verify Segments Can Be Read, Installed and De-installed From A Remote DISK Drive On the Candidate Platform (kpccp)
	

	D.3.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Installer window, click Select Source, in the Source field.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	D.3.2
	In the Host field verify that REMOTE is selected.
	REMOTE is selected.
	Circle one:  PASS / FAIL



	D.3.3
	In the Device field, click DISK.
	The Select File window appears.
	Circle one:  PASS / FAIL



	D.3.4
	In the Filter text box type: /kpchostdsk/si/* [r]
	/kpchostdsk/si/* appears in the text box.
	Circle one:  PASS / FAIL



	D.3.5
	In the Files field double-click bigseg.tar.
	The Select File window disappears. 

The Installer window reappears.
	Circle one:  PASS / FAIL



	D.3.6
	Click Read Contents.
	The Installer window returns with Big Test Segment appearing in the Select Software To Install field.
	Circle one:  PASS / FAIL



	D.3.7
	Select Big Test Segment in the Select Software To Install field.
	Big Test Segment is highlighted and the Disk column in the Select Software To Install field displays /home1.  If it doesn’t, deselect the segment and reselect it.


	Circle one:  PASS / FAIL



	D.3.8
	At the bottom of the Installer window select Install.
	Test Segment segx installs accordingly under /home1.  Once installed, it appears under Select Software To Install marked by an asterisk and is listed under Currently Installed Segments field.
	Circle one:  PASS / FAIL



	D.3.9
	In the Currently Installed Segments field select Big Test Segment.
	Big Test Segment is highlighted.
	Circle one:  PASS / FAIL



	D.3.10
	Click Deinstall Software.


	A RESPOND TO THE QUESTION dialog box appears with the message: 

Do you really want to remove the segments?

Big Test Segment?
	Circle one:  PASS / FAIL



	D.3.11
	Click Yes.
	Big Test Segment deinstalls correctly.
	Circle one:  PASS / FAIL



	D.4
	Resume the Export Of the CD-ROM Drive (Share the Root Directory Of the Installed CD) On the Validation Hosts (kpchost)
	

	D.4.1
	NOTE: Perform the following steps on the Validation host (kpchost).

Insert the KPC Test Data CD-ROM into the CD-ROM drive.
	The CD-ROM is inserted.
	Setup

	D.4.2
	In the Terminal window, at the command prompt type

share –o ro=kpccp /cdrom/kpc_4204
	The command prompt returns.
	Setup

	D.4.3
	At the command prompt type

share 
	The following text is displayed:

/kpc ro=kpccp

/home2 ro,root=kpccp

/cdrom/kpc_4204 ro=kpccp
	Setup

	D.5
	Verify Segments Can Be read and Installed From A Remote CD-ROM Drive (Share and Mount the Root Directory Of the Installed CD) On the Candidate Platform (kpccp)
	

	D.5.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Installer window, click Select Source, in the Source field.
	The Select Source window appears.
	Setup



	D.5.2
	In the Host field SELECT REMOTE.
	REMOTE is selected.
	Circle one:  PASS / FAIL



	D.5.3
	Type kpchost in the NAME test box.
	kpchost appears in the NAME test box.
	Circle one:  PASS / FAIL



	D.5.4
	In the Device field, click CD-ROM.
	The Select File window appears.
	Circle one:  PASS / FAIL



	D.5.5
	Enter the following in the Selection text box:

/kpchostcdrom/segx.tar
	/kpchostcdrom/segx.tar appears in the text box.
	Circle one:  PASS / FAIL



	D.5.6
	Click OK.
	The Installer window reappears.
	Circle one:  PASS / FAIL



	D.5.7
	In the Source field, click Read Contents.
	The Installer reads the Table of Contents.  When complete, the Installer displays the Select Software To Install field. 
	Circle one:  PASS / FAIL



	D.5.8
	In the Available Disks field select /home1
	/home1 is highlighted.
	Circle one:  PASS / FAIL



	D.5.9
	In the Select Software To Install field, select Test Segment segx.
	Test Segment segx is highlighted and the Disk column in the Select Software To Install field displays /home1.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	D.5.10
	Click Install.
	The following message appears:

Please Insert CD Volume #1 for the segment ‘Test Segment segx’.
When you are ready press the OK button.
	Circle one:  PASS / FAIL



	D.5.11
	Click OK.
	Test Segment segx installs accordingly under /home1.  Once installed, it appears under Select Software To Install marked by an asterisk and is listed under the Currently Installed Segments field.
	Circle one:  PASS / FAIL



	D.5.12
	In the Currently Installed Segments field, select Test Segment segx.
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	D.5.13
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Test Segment segx
	Circle one:  PASS / FAIL



	D.5.14
	Click Yes.
	The segment deinstalls and is not listed under Currently Installed Segments.
	Circle one:  PASS / FAIL



	D.5.15
	Click Exit.


	The Installer window closes.
	Circle one:  PASS / FAIL

	D.6
	Cleanup – Eject the CD-ROM On the Validation Host (kpchost)
	

	D.6.1
	NOTE: Perform the following steps on the Validation Host (kpchost).

In the Terminal window, at the command prompt type 
unshare /cdrom/kpc_4204
	The command prompt returns.
	Cleanup

	D.6.2
	At the command prompt type

share 
	The following text is displayed:

/kpc ro=kpccp

/home2 ro,root=kpccp
	Cleanup

	D.6.3
	At the command prompt type 

eject
	The CD-ROM is ejected.
	Cleanup

	D.7
	Verify Segments Can Be Read and Install Segments From A Remote tape drive  (Select Source  -  EXABYTE)

Optional test if vendor supports Exabyte drives
	

	E
	Test the Runtime Tools

	E.1
	Install the Runtime Tools Segment On the Candidate Platform (kpccp)

NOTE: Any incorrect input in the steps below will cause the Runtime Tools Segment to fail to load.  To determine where the failure occurred, search the /tmp/out.log file for the word FAILED.  Then run step E.1 again.
	

	E.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Terminal window, at the command prompt type the following as sysadmin:

/h/COE/bin/COEInstaller |& tee [s]

/tmp/out.log
	The Installer window opens and displays messages in the terminal.
	Circle one:  PASS / FAIL



	E.1.2
	In the Installer window, click Select Source in the Source field.
	The Select Source dialog box appears.
	Circle one:  PASS / FAIL



	E.1.3
	In the Host field, verify LOCAL is selected.
	LOCAL is selected.
	Circle one:  PASS / FAIL



	E.1.4
	In the Device field, select DISK. 
	The Select File dialog box appears.
	Circle one:  PASS / FAIL



	E.1.5
	In the Selection text box, type

/kpc/si/RTTseg.tar
	/kpc/si/RTTseg.tar appears in the text box.
	Circle one:  PASS / FAIL



	E.1.6
	Click OK.
	The Select File and Select Source dialog boxes disappear.
	Circle one:  PASS / FAIL



	E.1.7
	In the Source field, click Read Contents.
	The Installer window shows Runtime  Tools Test Segment listed under Select Software To Install.
	Circle one:  PASS / FAIL



	E.1.8
	Select Runtime Tools Test Segment.
	Runtime Tools Test Segment is highlighted and the Disk column in the Select Software To Install field displays /h.
	Circle one:  PASS / FAIL



	E.1.9
	Click Install.
	An ENTER A PASSWORD dialog box appears.
	Circle one:  PASS / FAIL



	E.1.10
	Enter the APM Authentication key in the text box.
	Asterisks appear in the text box.
	Circle one:  PASS / FAIL



	E.1.11
	Click OK.
	A dialog box appears stating:

Please wait...extracting the disk file with the selected segment: ‘Runtime Tools Segment’
Then, a sequence of dialog boxes appears.
	Circle one:  PASS / FAIL



	E.1.12
	Enter the requested text in each dialog box.
	An ENTER A RESPONSE dialog box appears:

Enter exactly “Now is the time” (expect beeps), click OK: 
	Circle one:  PASS / FAIL



	E.1.13
	In the text box, type 

Now is the time
	Now is the time is entered in the text box.

NOTE: The word “time” is not displayed.
	Circle one:  PASS / FAIL



	E.1.14
	Click OK.
	An ENTER A RESPONSE dialog box appears:

Enter exactly “Test*_1%-@”, click OK:
	Circle one:  PASS / FAIL



	E.1.15
	In the text box, type 

Test*_1%-@
	Test*_1%-@ is entered in the text box.


	Circle one:  PASS / FAIL



	E.1.16
	Click OK.
	An ENTER A RESPONSE dialog box appears:

Enter exactly “9”, click OK:
	Circle one:  PASS / FAIL



	E.1.17
	In the text box, type 

9
	9 is entered in the text box.


	Circle one:  PASS / FAIL



	E.1.18
	Click OK.
	An ENTER A RESPONSE dialog box appears:

Enter nothing, click OK:
	Circle one:  PASS / FAIL



	E.1.19
	Click OK.
	An ENTER A RESPONSE dialog box appears:

Enter exactly “0123456789” 5 times in sequence (expect beeps), click OK:
	Circle one:  PASS / FAIL



	E.1.20
	In the text box, type

01234567890123456789012345678901234567890123456789
	01234567890123456789012345678901234567890123456789 is entered in the text box.

NOTE: 4 sets of 0123456789 will appear in the text box.
	Circle one:  PASS / FAIL



	E.1.21
	Click OK.
	An ENTER A RESPONSE dialog box appears:

COEPrompt is similar to COEMsg, but expects the user to enter a response.  The syntax is:  “COEPrompt {parameters} msg” where msg is the string to display.  

Enter “Yes” exactly and click OK if the above sentence is complete.  Otherwise, enter nothing and click OK:
	Circle one:  PASS / FAIL



	E.1.22
	In the test box, type

Yes
	Yes is entered in the text box.


	Circle one:  PASS / FAIL



	E.1.23
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears:

Can you read this prompt?
	Circle one:  PASS / FAIL



	E.1.24
	Click Yes.
	An ENTER A RESPONSE dialog box appears:

On the next prompt, if the message says only ‘Hello’ click the No button; otherwise click Yes.

For all following prompts, if no message appears, click the button on the right.  

To continue, type nothing and click OK below:
	Circle one:  PASS / FAIL



	E.1.25
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears with the following:

Hello
	Circle one:  PASS / FAIL



	E.1.26
	Click No.
	A RESPOND TO THE QUESTION dialog box appears:

If the buttons below show True and False, click the True button.  Otherwise, click the button on the right.
	Circle one:  PASS / FAIL



	E.1.27
	Click True.
	A RESPOND TO THE QUESTION dialog box appears:

If the buttons below show True and False, click the False button.  Otherwise, click the button on the left.
	Circle one:  PASS / FAIL



	E.1.28
	Click False.
	A RESPOND TO THE QUESTION dialog box appears:

If the buttons below show Accept and Cancel, click the Accept button.  Otherwise, click the button on the right.
	Circle one:  PASS / FAIL



	E.1.29
	Click Accept.
	A RESPOND TO THE QUESTION dialog box appears:

If the buttons below show Accept and Cancel, click the Cancel button.  Otherwise, click the button on the left.
	Circle one:  PASS / FAIL



	E.1.30
	Click Cancel.
	A RESPOND TO THE QUESTION dialog box appears:

If the buttons below show Exit and Cancel, click the Exit button.  Otherwise, click the button on the right.
	Circle one:  PASS / FAIL



	E.1.31
	Click Exit.
	A RESPOND TO THE QUESTION dialog box appears:

If the buttons below show “Exit or Cancel” and “Continue”, click the “Exit or Cancel” button.  Otherwise, click the button on the right.
	Circle one:  PASS / FAIL



	E.1.32
	Click Exit or Cancel.
	A RESPOND TO THE QUESTION dialog box appears:

If the buttons below show Yes and No, click the Yes button.  Otherwise, click the button on the right.
	Circle one:  PASS / FAIL



	E.1.33
	Click Yes.
	A RESPOND TO THE QUESTION dialog box appears:

If the buttons below show True and False, click the True button. Otherwise, click the button on the right.
	Circle one:  PASS / FAIL



	E.1.34
	Click True.
	An ENTER A RESPONSE dialog box appears:

On the next prompt, if the message is exactly “Test*_1%-@”, and Yes and No buttons are shown, click the No button.  Otherwise, click the button on the left.

Type nothing and click OK to continue:
	Circle one:  PASS / FAIL



	E.1.35
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears with the following:

Test*_1%-@
	Circle one:  PASS / FAIL



	E.1.36
	Click No.
	An ENTER A RESPONSE dialog box appears:

On the next prompt, if the message area is blank, and Yes and No buttons are shown, click the Yes button.  Otherwise, click the button on the right.

Type nothing and click OK to continue:
	Circle one:  PASS / FAIL



	E.1.37
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears with no message.
	Circle one:  PASS / FAIL



	E.1.38
	Click Yes.
	An ENTER A RESPONSE dialog box appears:

On the next prompt, write down the message shown and click the OK button.

Type nothing and click OK to continue: 
	Circle one:  PASS / FAIL



	E.1.39
	Click OK.
	An INFORMATIONAL MESSAGE dialog box appears with the following:

Test*_1%-@
	Circle one:  PASS / FAIL



	E.1.40
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears:

On the next prompt, write down the message shown and click the OK button.

Was the previous message exactly “Test*_1%-@”?
	Circle one:  PASS / FAIL



	E.1.41
	Click Yes.
	An INFORMATIONAL MESSAGE dialog box appears with the following:

Test
	Circle one:  PASS / FAIL



	E.1.42
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears:

On the next prompt, write down the message shown and click the OK button.

Was the previous message exactly “Test”?
	Circle one:  PASS / FAIL



	E.1.43
	Click Yes.
	An INFORMATIONAL MESSAGE dialog box appears with the following:

Single quote pass
	Circle one:  PASS / FAIL



	E.1.44
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears:

On the next prompt, write down the message shown and click the OK button.

Was the previous message exactly “Single quote pass”?
	Circle one:  PASS / FAIL



	E.1.45
	Click Yes.
	An INFORMATIONAL MESSAGE dialog box appears with no message.
	Circle one:  PASS / FAIL



	E.1.46
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears:

On the next prompt, remember the message shown and click the OK button.

Was the previous message blank?
	Circle one:  PASS / FAIL



	E.1.47
	Click Yes.
	An INFORMATIONAL MESSAGE dialog box appears:

I pledge allegiance to the flag of the United States of America And to the republic for which it stands one nation, under God, indivisible, with liberty and justice for all.
	Circle one:  PASS / FAIL



	E.1.48
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears:

On the next prompt, remember the message shown and click the OK button.

Was the previous message the complete pledge of allegiance?
	Circle one:  PASS / FAIL



	E.1.49
	Click Yes.
	An ENTER A PASSWORD dialog box appears:

Enter exactly “password” for both, click OK:

Password (text box)
Verify   (text box)
	Circle one:  PASS / FAIL



	E.1.50
	Type password in both text boxes.
	Asterisks appear in the text boxes.
	Circle one:  PASS / FAIL



	E.1.51
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears:

Did the password entry fields only display asterisks (*) as you typed?
	Circle one:  PASS / FAIL



	E.1.52
	Click Yes.
	An ENTER A RESPONSE dialog box appears:

On the next prompt, enter “sample” for the password and click OK.

Enter nothing here and click OK to continue.
	Circle one:  PASS / FAIL



	E.1.53
	Click OK.
	An ENTER A PASSWORD dialog box appears:

Password (text box)
	Circle one:  PASS / FAIL



	E.1.54
	Type sample in the text box.
	Asterisks appear in the text box.
	Circle one:  PASS / FAIL



	E.1.55
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears:

In the previous prompt, did only the password entry field appear, with no message, and no verify field?
	Circle one:  PASS / FAIL



	E.1.56
	Click Yes.
	An ENTER A PASSWORD dialog box appears:

Enter exactly ‘password’

Password (text box)
	Circle one:  PASS / FAIL



	E.1.57
	Type password in the text box.
	Asterisks appear in the text box.
	Circle one:  PASS / FAIL



	E.1.58
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears:

In the previous prompt, did only the password entry field appear, with no verify field?
	Circle one:  PASS / FAIL



	E.1.59
	Click Yes.
	An ENTER A RESPONSE dialog box appears:

On the next prompt, enter “test1234” for the password, verify and click OK.

Enter nothing here and click OK to continue.
	Circle one:  PASS / FAIL



	E.1.60
	Click OK.
	An ENTER A PASSWORD dialog box appears:

Password (text box)
Verify   (text box)
	Circle one:  PASS / FAIL



	E.1.61
	Type test1234 in the text boxes.
	Asterisks appear in the text boxes.
	Circle one:  PASS / FAIL



	E.1.62
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears:

In the previous prompt, did both the password and verify fields appear, with no message?
	Circle one:  PASS / FAIL



	E.1.63
	Click Yes.
	An ENTER A RESPONSE dialog box appears:

On the next prompt, enter “Test*_1%-@” for the password, verify and click OK.

Enter nothing here and click OK to continue.
	Circle one:  PASS / FAIL



	E.1.64
	Click OK.
	An ENTER A PASSWORD dialog box appears:

Password (text box)
Verify   (text box)
	Circle one:  PASS / FAIL



	E.1.65
	Type Test*_1%-@ in the text boxes.
	Asterisks appear in the text boxes.
	Circle one:  PASS / FAIL



	E.1.66
	Click OK.
	An ENTER A PASSWORD dialog box appears:

The first time you see this prompt, enter “012345678901234” for the password and verification and click OK. (This should return an error message – write it down.)  The second time, enter “tested” and clickOK.

Password (text box)
Verify   (text box)
	Circle one:  PASS / FAIL



	E.1.67
	Type 012345678901234 in the text boxes.
	Asterisks appear in the text boxes.
	Circle one:  PASS / FAIL



	E.1.68
	Click OK.
	An INFORMATIONAL MESSAGE dialog box appears with the following:

Password must be 6 to 14 characters in length!
	Circle one:  PASS / FAIL



	E.1.69
	Click OK.
	An ENTER A PASSWORD dialog box appears:

The first time you see this prompt, enter “012345678901234” for the password and verification and click OK. (This should return an error message – write it down.)  The second time, enter “tested” and clickOK.

Password (text box)
Verify   (text box)
	Circle one:  PASS / FAIL



	E.1.70
	Type tested in the text boxes.
	Asterisks appear in the text boxes.
	Circle one:  PASS / FAIL



	E.1.71
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears:

In the previous prompts, did you receive one error message indicating that the password must be 6 – 14 characters in length?
	Circle one:  PASS / FAIL



	E.1.72
	Click Yes.
	An ENTER A RESPONSE dialog box appears:

For the next two prompts, duplicate the prompt message in the password field and click OK.

Enter nothing here and click OK to continue:
	Circle one:  PASS / FAIL



	E.1.73
	Click OK.
	An ENTER A PASSWORD dialog box appears:

Test*_1%-@

Password (text box)
	Circle one:  PASS / FAIL



	E.1.74
	Type Test*_1%-@ in the text box.
	Asterisks appear in the text box.
	Circle one:  PASS / FAIL



	E.1.75
	Click OK.
	An ENTER A PASSWORD dialog box appears:

%TestCase

Password (text box)
	Circle one:  PASS / FAIL



	E.1.76
	Type %TestCase in the text box.
	Asterisks appear in the text box.
	Circle one:  PASS / FAIL



	E.1.77
	Click OK.
	An ENTER A RESPONSE dialog box appears:

For the next three prompts, enter nothing in the password field and click OK.

Enter nothing here and click OK to continue:
	Circle one:  PASS / FAIL



	E.1.78
	Click OK.
	An ENTER A PASSWORD dialog box appears:

Password (text box)
Verify   (text box)
	Circle one:  PASS / FAIL



	E.1.79
	Click OK.
	An ENTER A PASSWORD dialog box appears:

Password (text box)
Verify   (text box)
	Circle one:  PASS / FAIL



	E.1.80
	Click OK.
	An ENTER A PASSWORD dialog box appears:

Password (text box)
Verify   (text box)
	Circle one:  PASS / FAIL



	E.1.81
	Click OK.
	An ENTER A RESPONSE dialog box appears:

For the next three prompts, enter “01234567890” in the password and verify fields and click OK. Respond to each error message by clicking OK.

Enter nothing here and click OK to continue:
	Circle one:  PASS / FAIL



	E.1.82
	Click OK.
	An ENTER A PASSWORD dialog box appears:

Password (text box)
Verify   (text box)
	Circle one:  PASS / FAIL



	E.1.83
	Type 01234567890 in the text boxes.
	Asterisks appear in the text boxes.
	Circle one:  PASS / FAIL



	E.1.84
	Click OK.
	An INFORMATIONAL MESSAGE dialog box appears with the following:

Password must be 6 to 10 characters in length!
	Circle one:  PASS / FAIL



	E.1.85
	Click OK.
	An ENTER A PASSWORD dialog box appears:

Password (text box)
Verify   (text box)
	Circle one:  PASS / FAIL



	E.1.86
	Type 01234567890 in the text boxes.
	Asterisks appear in the text boxes.
	Circle one:  PASS / FAIL



	E.1.87
	Click OK.
	An INFORMATIONAL MESSAGE dialog box appears with the following:

Password must be 6 to 10 characters in length!
	Circle one:  PASS / FAIL



	E.1.88
	Click OK.
	An ENTER A PASSWORD dialog box appears:

Password (text box)
Verify   (text box)
	Circle one:  PASS / FAIL



	E.1.89
	Type 01234567890 in the text boxes.
	Asterisks appear in the text boxes.
	Circle one:  PASS / FAIL



	E.1.90
	Click OK.
	An INFORMATIONAL MESSAGE dialog box appears with the following:

Password must be 6 to 10 characters in length!
	Circle one:  PASS / FAIL



	E.1.91
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears:

In the previous prompt, you receive 3 error messages indicating that the password must be 6 – 10 characters in length?
	Circle one:  PASS / FAIL



	E.1.92
	Click Yes.
	An ENTER A PASSWORD dialog box appears:

Enter ‘012345678’. Click OK on errors

Password (text box)
Verify   (text box)
	Circle one:  PASS / FAIL



	E.1.93
	Type 012345678 in the text boxes.
	Asterisks appear in the text boxes.
	Circle one:  PASS / FAIL



	E.1.94
	Click OK.
	An INFORMATIONAL MESSAGE dialog box appears with the following:

Password must be 6 to 8 characters in length!
	Circle one:  PASS / FAIL



	E.1.95
	Click OK.
	An ENTER A PASSWORD dialog box appears:

Enter ‘012345678’. Click OK on errors

Password (text box)
Verify   (text box)
	Circle one:  PASS / FAIL



	E.1.96
	Type 012345678 in the text boxes.
	Asterisks appear in the text boxes.
	Circle one:  PASS / FAIL



	E.1.97
	Click OK.
	An INFORMATIONAL MESSAGE dialog box appears with the following:

Password must be 6 to 8 characters in length!
	Circle one:  PASS / FAIL



	E.1.98
	Click OK.
	An ENTER A PASSWORD dialog box appears:

Enter ‘012345678’. Click OK on errors

Password (text box)
Verify   (text box)
	Circle one:  PASS / FAIL



	E.1.99
	Type 012345678 in the text boxes.
	Asterisks appear in the text boxes.
	Circle one:  PASS / FAIL



	E.1.100
	Click OK.
	An INFORMATIONAL MESSAGE dialog box appears with the following:

Password must be 6 to 8 characters in length!
	Circle one:  PASS / FAIL



	E.1.101
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears:

In the previous prompts, you receive 3 error messages indicating that the password must be 6 – 8 characters in length?
	Circle one:  PASS / FAIL



	E.1.102
	Click Yes.
	An ENTER A RESPONSE dialog box appears:

For the next prompt, enter “testing” in the password and verify fields and click OK.

Enter nothing here and click OK to continue:
	Circle one:  PASS / FAIL



	E.1.103
	Click OK.
	An ENTER A PASSWORD dialog box appears:

Password (text box)
Verify   (text box)
	Circle one:  PASS / FAIL



	E.1.104
	Type testing in the text boxes.
	Asterisks appear in the text boxes.
	Circle one:  PASS / FAIL



	E.1.105
	Click OK.
	An ENTER A PASSWORD dialog box appears:

COEPromptPasswd is similar to COEPrompt in syntax and operation. It is intended to be used in PreInstall and PostInstall to ask the user for a password.

Enter ‘testing’

Password (text box)
Verify   (text box)
	Circle one:  PASS / FAIL



	E.1.106
	Type testing in the text boxes.
	Asterisks appear in the text boxes.
	Circle one:  PASS / FAIL



	E.1.107
	Click OK.
	A RESPOND TO THE QUESTION dialog box appears:

In the previous prompt, did the message appear on several lines ?
	Circle one:  PASS / FAIL



	E.1.108
	Click Yes.

NOTE: Any incorrect input in the above steps will cause the Runtime Tools Segment to fail to load.  To determine where the failure occurred, search the /tmp/out.log file for the word FAILED.  Then run step E.1 again.
	The following dialog box appears:

Building segment lists…
The Installer window returns to the forefront and shows Runtime Tools Segment listed under Currently Installed Segments.
	Circle one:  PASS / FAIL



	E.1.109
	Open another Terminal window.
	A Terminal window appears with a command line prompt.
	Setup

	E.1.110
	At the command prompt type

grep FAILED /tmp/out.log
	The command prompt returns without any Sub-test

indicated as FAILED.
	Circle one:  PASS / FAIL



	E.2
	Deinstall the Runtime Tools Segment On the Candidate Platform (kpccp)
	

	E.2.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Segment Installer window, select the Runtime Tools Segment segment in the Currently Installed Segments field.
	The Runtime Tools Segment segment in the Currently Installed Segments field is highlighted.
	Cleanup

	E.2.2
	Click Deinstall Software.
	The following dialog box appears:

Do you really want to remove the segments?

Runtime Tools Segment
	Cleanup

	E.2.3
	Click Yes.
	The following dialog box appears:

Segment deinstallation in progress...

Control returns to the Segment Installer window.
	Cleanup

	E.2.4
	When removal is complete, check both the Currently Installed Segments field and the Select Software to Install field.
	The Runtime Tools Segment segment is no longer listed in the Currently Installed Segments field.

An asterisk (*) no longer appears next to the Runtime Tools Segment segment in the Select Software to Install field.
	Cleanup

	E.2.5
	Click Exit in the bottom menu bar of the Segment Installer.
	The Segment Installer window disappears.
	Cleanup

	F
	Segment Type Tests

	F.1
	Verify That All Segment Types Can Be Installed By the Segment Installer On the Candidate Platform (kpccp)
	

	F.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Application Manager – SysAdm window, double-click Segment Installer.
	The Installer window appears.
	Setup

	F.1.2
	In the Installer window, click Select Source in the Source field.
	The Select Source window appears.
	Setup

	F.1.3
	In the Device field, click DISK.
	The DISK option is selected and the Select File dialog box appears.
	Setup

	F.1.4
	In the Filter text box, type

/kpc/si/* [r]
	/kpc/si/* appears in the text box.
	Setup

	F.1.5
	In the Files field, double-click on the following entry:

all_types.tar
	The Installer window reappears.
	Circle one:  PASS / FAIL



	F.1.6
	In the Source field, click Read Contents.

NOTE: Resize the Installer window to view all segments.
	The following segments appear in the Select Software To Install field:

Sample Aggregate Segment

Sample Account Group Segment

Sample COE Child Segment

Sample COTS Segment

Sample Data-Global Segment

Sample Data-Local Segment

Sample Data-Segment Segment

Sample Software Segment

SampleSW.P1
	Circle one:  PASS / FAIL



	F.1.7
	Select the following segments in the Select Software To Install field:

Sample Aggregate Segment

Sample Account Group Segment

Sample COE Child Segment

Sample COTS Segment

Sample Software Segment
	All requested segments in the Select Software To Install field are highlighted.
	Circle one:  PASS / FAIL



	F.1.8
	Click Install.
	An ENTER A PASSWORD dialog box appears asking for the Master APM Authentication key.
	Circle one:  PASS / FAIL



	F.1.9
	Enter the Master APM Authentication key in the text box.
	Asterisks appear in the text box.
	Circle one:  PASS / FAIL



	F.1.10
	Click OK.
	The working box may be blank, or the following dialog boxes will appear in sequence:

Please wait...extracting the disk file with the selected segment: ‘Sample Aggregate Segment’

Please wait...extracting the disk file with the selected segment: ‘Sample Aggregate Child Segment’

PreInstall installation directory is /h/AcctGrps/SampleAcctGrp
	Circle one:  PASS / FAIL



	F.1.11
	Click OK.
	The working box may be blank, or the following dialog boxes will appear in sequence:

Please wait...extracting the disk file with the selected segment: ‘Sample Account Group Segment’

PostInstall installation directory is /h/AcctGrps/SampleAcctGrp
	Circle one:  PASS / FAIL



	F.1.12
	Click OK.
	The following dialog box appears:

PreInstall installation directory is /h/COE/Comp/SampleCOEChild
	Circle one:  PASS / FAIL



	F.1.13
	Click OK.
	The following dialog boxes appear in sequence:

Please wait...extracting the disk file with the selected segment: ‘Sample COE Child Segment’
PostInstall installation directory is /h/COE/Comp/SampleCOEChild
	Circle one:  PASS / FAIL



	F.1.14
	Click OK.
	The following dialog boxes appear in sequence:

Please wait...extracting the disk file with the selected segment: ‘Sample COTS Segment’
PreInstall installation directory is /h/SampleSW
	Circle one:  PASS / FAIL



	F.1.15
	Click OK.
	The following dialog boxes appear in sequence:

Please wait...extracting the disk file with the selected segment: ‘Sample Software Segment’
PostInstall installation directory is /h/SampleSW
	Circle one:  PASS / FAIL



	F.1.16
	Click OK.
	The following dialog box appears:

Building segment lists…
The Installer window returns to the forefront.
	Circle one:  PASS / FAIL



	F.1.17
	When installation is complete, check both the Currently Installed Segments field and the Select Software To Install field.

NOTE: Resize the Installer window to view all segments.
	The following segments are listed in the Currently Installed Segments field:

Sample Aggregate Segment

Sample Account Group Segment

Sample COE Child Segment

Sample COTS Segment

Sample Software Segment

An asterisk (*) appears next to the aforementioned segments in the Select Software To Install field.
	Circle one:  PASS / FAIL



	F.1.18
	Select the following segments in the Select Software To Install field:

Sample Data-Global Segment

Sample Data-Local Segment

Sample Data-Segment Segment

SampleSW.P1
	All requested segments in the Select Software To Install field are highlighted.
	Circle one:  PASS / FAIL



	F.1.19
	Click Install.
	The working box may be blank, or the following dialog boxes will appear in sequence:

Please wait...extracting the disk file with the selected segment: ‘Sample Data-Global Segment’

Please wait...extracting the disk file with the selected segment: ‘Sample Data-Local Segment’

Please wait...extracting the disk file with the selected segment: ‘Sample Data-Segment Segment’

Please wait...extracting the disk file with the selected segment: ‘SampleSW.P1’

Building segment lists…
Control returns to the Installer window.
	Circle one:  PASS / FAIL



	F.1.20
	When installation is complete, check both the Currently Installed Segments field and the Select Software To Install field.

NOTE: Resize the Installer window to view all segments.
	All sample segments are listed in the Currently Installed Segments field.

An asterisk (*) appears next to all sample segments in the Select Software To Install field.
	Circle one:  PASS / FAIL



	F.2
	Verify That All Segments Are Installed Onto the Hard Disk On the Candidate Platform (kpccp)
	

	F.2.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).
Verify that Sample Aggregate Segment, Sample Aggregate Child Segment, Sample Data-Global Segment, Sample Data-Local Segment, Sample Data-Segment Segment, and Sample Software Segment are installed onto the hard disk.

In the Terminal window at the command prompt, type

ls /h
	The following directories are listed:

SampleAgg
SampleAggChild
SampleDataGlobal
SampleDataLocal
SampleDataSegment
SampleSW
	Circle one:  PASS / FAIL



	F.2.2
	Verify that Sample Account Group Segment is installed onto the hard disk. 

At the command prompt, type

ls /h/AcctGrps
	The directory SampleAcctGrp is listed.
	Circle one:  PASS / FAIL



	F.2.3
	Verify that Sample COE Child Segment is installed onto the hard disk. 

At the command prompt, type

ls /h/COE/Comp
	The directory SampleCOEChild is listed.
	Circle one:  PASS / FAIL



	F.2.4
	Verify that Sample COTS Segment is installed onto the hard disk. 

At the command prompt, type

ls /h/COTS
	The directory SampleCOTS is listed.
	Circle one:  PASS / FAIL



	F.2.5
	Verify that Sample Data-Local Segment is installed onto the hard disk. 

At the command prompt, type

ls /h/data/local
	The directory SampleDataLocal is listed.
	Circle one:  PASS / FAIL



	F.2.6
	Verify that Sample Data-Global Segment is installed onto the hard disk. 

At the command prompt, type

ls /h/data/global
	The directory SampleDataGlobal is listed.
	Circle one:  PASS / FAIL



	F.2.7
	Verify that Sample Data-Segment Segment is installed onto the hard disk. 

At the command prompt, type

ls /h/SampleSW/data
	The directory SampleDataSegment is listed.
	Circle one:  PASS / FAIL



	F.2.8
	Verify that SampleSoftware Segment is installed onto the hard disk. 

At the command prompt, type

ls /h/SampleSW/Patches
	The directory P1 is listed.
	Circle one:  PASS / FAIL



	F.3
	Verify That All Segment Types Can Be Removed By the Segment Installer On the Candidate Platform (kpccp)
	

	F.3.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).
In the Installer window, select SampleSW.P1 in the Currently  Installed Segments field.
	SampleSW.P1 is highlighted.
	Circle one:  PASS / FAIL



	F.3.2
	Click Deinstall Software.
	The following dialog box appears:

Do you really want to remove the segments?

SampleSW.P1
	Circle one:  PASS / FAIL



	F.3.3
	Click Yes.
	The working box may be blank, or the following dialog box will appear:

Segment deinstallation in progress...

Control returns to the Installer window.
	Circle one:  PASS / FAIL



	F.3.4
	When removal is complete, check both the Currently Installed Segments field and the Select Software To Install field.

NOTE: Resize the Installer window to view all segments.
	The SampleSW.P1 segment is no longer listed in the Currently Installed Segments field.

An asterisk (*) no longer appears next to the SampleSW.P1 segment in the Select Software To Install field.
	Circle one:  PASS / FAIL



	F.3.5
	In the Currently Installed Segments field, select the following segments:

Sample Aggregate Segment

Sample Account Group Segment

Sample COE Child Segment

Sample COTS Segment

Sample Data-Global Segment

Sample Data-Local Segment

Sample Data-Segment Segment

Sample Software Segment
	All requested segments in the Currently Installed Segments field are highlighted.
	Circle one:  PASS / FAIL



	F.3.6
	Click Deinstall Software.
	The following dialog box appears:

Do you really want to remove the segments?

Sample Data-Segment Segment
Sample Data-Local Segment
Sample Data-Global Segment
Sample Software Segment
Sample Aggregate Segment
Sample COE Child Segment
Sample COTS Segment
Sample Account Group Segment
	Circle one:  PASS / FAIL



	F.3.7
	Click Yes.
	The working box may be blank, or the following dialog boxes will appear in sequence:
Segment deinstallation in progress...

Building segment lists…

DEINSTALL installation directory is /h/SampleSW
	Circle one:  PASS / FAIL



	F.3.8
	Click OK.
	The following dialog box appears:

DEINSTALL installation directory is /h/COE/Comp/SampleCOEChild
	Circle one:  PASS / FAIL



	F.3.9
	Click OK.
	The following dialog box appears:

DEINSTALL installation directory is /h/AcctGrps/SampleAcctGrp
	Circle one:  PASS / FAIL



	F.3.10
	Click OK.
	The following dialog box appears:

Building segment lists…

Control returns to the Installer window.
	Circle one:  PASS / FAIL



	F.3.11
	When removal is complete, check both the Currently Installed Segments field and the Select Software To Install field.

NOTE: Resize the Installer window to view all segments.
	All sample segments are no longer listed in the Currently Installed Segments field.

An asterisk (*) no longer appears next to the all segments in the Select Software To Install field.
	Circle one:  PASS / FAIL



	G
	Test the Process Descriptor

	G.1
	Install Processes Test Segment On the Candidate Platform (kpccp)
	

	G.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Installer window click Select Source.
	The Select Source dialog box appears.
	Circle one:  PASS / FAIL



	G.1.2
	In the Device field, select DISK.


	The Select File dialog box appears.
	Circle one:  PASS / FAIL



	G.1.3
	In the Files list box select

ProcSeg.tar
	ProcSeg.tar is highlighted.
	Circle one:  PASS / FAIL



	G.1.4
	Click OK.
	The Select File and Select Source dialog boxes disappear.  The Installer window reappears.
	Circle one:  PASS / FAIL



	G.1.5
	Click Read Contents.
	In the Installer window, Processes Test Segment is listed under Select Software To Install.
	Circle one:  PASS / FAIL



	G.1.6
	Select Processes Test Segment.


	Processes Test Segment is highlighted and the Disk column in the Select Software To Install field displays /h.
	Circle one:  PASS / FAIL



	G.1.7
	Click Install.
	The following dialog box appears:

Building segment lists…
The Installer window returns to the forefront and shows Processes Test Segment listed under Currently Installed Segments.
	Circle one:  PASS / FAIL



	G.1.8
	In the Application Manager – SysAdm window double-click Reboot System.
	The  Reboot window appears with the message:

Reboot machine?


	Setup

	G.1.9
	Click Yes.


	The machine reboots.
	Setup

	G.2
	Verify Boot, Run-Once, and Periodic Processes Were Started On the Candidate Platform (kpccp)
	

	G.2.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Login as secman.
	The desktop appears.
	Setup

	G.2.2
	Open a Terminal window.
	A Terminal window appears with a command line prompt.
	Setup

	G.2.3
	At the command prompt type 

su -
	The Password prompt appears.
	Setup

	G.2.4
	At the Password prompt type the root password.
	The command prompt returns.
	Setup

	G.2.5
	At the command prompt type

csh
	The command prompt returns.
	Setup

	G.2.6
	At the command prompt type

date
	The current system date and time are displayed.
	Setup

Date:_____________

Time:_____________

	G.2.7
	Wait 5 minutes so that the period process will have had time to start.
	
	Setup

	G.2.8
	At the command prompt type

/h/ProcSeg/bin/PROC-check-install
	The output contains several lines indicating started processes.

The following process show start time the same as the last reboot:

PROC-boot-process

PROC-boot-process-coe

PROC-boot-process-secman

PROC-run-once-process 

The following processes are started:

PROC-periodic-process-a

PROC-periodic-process-b


	Circle one:  PASS / FAIL



	G.3
	Verify Session Processes Were Started On the Candidate Platform (kpccp)
	

	G.3.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Select Applications > Application Manager > DII_APPS > SecAdm.
	The Application Manager – SecAdm window appears.
	Setup



	G.3.2
	In the Application Manager – SecAdm dialog box, double-click APM Client.
	An Input dialog box appears asking for the master APM authentication key.


	Setup

	G.3.3
	Enter the master APM authentication Key.
	Asterisks appear in the text box.
	Setup



	G.3.4
	Click OK.
	The Account and Profile Manager dialog box appears.
	Setup



	G.3.5
	Click Profiles.
	The Profiles tab is displayed.
	Setup



	G.3.6
	Select File > New Profile.
	The Create Profile dialog box appears.
	Setup



	G.3.7
	Click Identification.
	The Identification tab is displayed.
	Setup



	G.3.8
	Enter the following value:

Profile Name: proc_prof

	proc_prof appears in the text box.
	Setup



	G.3.9
	Click Features.
	The Features tab is displayed.
	Setup



	G.3.10
	Select SOL Processes Test Segment from the Segments panel.
	SOL Processes Test Segment is highlighted. The SOL Process Test Segment-Proc Icon feature appears in the Features panel.
	Setup



	G.3.11
	Select SOL Process Test Segment-Proc Icon in the Features panel.
	SOL Process Test Segment-Proc Icon is selected
	Setup



	G.3.12
	Click Hosts.
	The Hosts tab is displayed.
	Setup



	G.3.13
	Double-click kpccp appear in the Availble Hosts panel.
	kpccp moves to the Assigned Hosts panel.
	Setup



	G.3.14
	Click Submit.
	A Status Summary dialog box appears indicating the new profile has been added.
	Setup



	G.3.15
	Click OK.
	Control returns to the Account and Profile Manager dialog box. 
	Setup



	G.3.16
	In the Account and Profile Manager dialog box, under Accounts, double-click user secman.
	A Modify Account: secman dialog box appears.
	Setup



	G.3.17
	Click Profiles.
	The Profiles tab is displayed.
	Setup



	G.3.18
	Double-click proc_prof.
	Profile proc_prof moves to the Assigned Profiles panel.
	Setup



	G.3.19
	Click Submit.
	A Status Summery dialog box appears indicating user secman was modified.
	Setup



	G.3.20
	Click OK to clear the Status Summary.
	Control returns to the Account and Profile Manager dialog box.
	Setup



	G.3.21
	Click Profile Selector (the head with a question mark).
	The Profile Selector window appears.
	Setup



	G.3.22
	Double-click proc_prof.
	Profile proc_prof moves to the Selected Profiles panel.
	Circle one:  PASS / FAIL



	G.3.23
	Click OK.
	An INFORMATIONAL MESSAGE dialog box appears with the message:

PROC: Session process has been started.
	Circle one:  PASS / FAIL



	G.3.24
	Click OK.
	The Profile Selector Results window appears stating that the profile was successfully assumed.
	Circle one:  PASS / FAIL



	G.3.25
	Click Done.
	The Profile Selector window and the Profile Selector Results window disappear.
	Circle one:  PASS / FAIL



	G.4
	Cleanup ProcSeg on the Candidate Platform (kpccp)
	

	G.4.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Click Profile Selector (the head with a question mark).
	The Profile Selector window appears with SSO Default listed in the Selected Profiles panel.
	Circle one:  PASS / FAIL

	G.4.2
	Double-click SSO Default.

Double-click proc_prof.
	Profile SSO Default moves to the Available Profiles panel.

proc_prof moves to the Selected Profiles panel.
	Circle one:  PASS / FAIL



	G.4.3
	Click OK.
	An INFORMATIONAL MESSAGE dialog box appears with the message:

PROC: Session exit process has been started.
	Circle one:  PASS / FAIL



	G.4.4
	Click OK.
	The Profile Selector Results window appears stating that the profile was successfully assumed.
	Circle one:  PASS / FAIL



	G.4.5
	Click Done.
	The Profile Selector window and the Profile Selector Results window disappear.
	Circle one:  PASS / FAIL



	G.4.6
	In the Account and Profile Manager dialog box, under Accounts, double-click user secman.
	A Modify Account: secman dialog box appears.
	Cleanup



	G.4.7
	Click Profiles.
	The Profiles tab is displayed.
	Cleanup 



	G.4.8
	Double-click proc_prof.
	Profile proc_prof moves to the Available Profiles panel.
	Cleanup



	G.4.9
	Click Submit.
	A Status Summery dialog box appears indicating user secman was modified.
	Cleanup



	G.4.10
	Click OK to clear the Status Summary.
	Control returns to the Account and Profile Manager dialog box.
	Cleanup



	G.4.11
	In the Account and Profile Manager dialog box, click Profiles.
	The Profiles tab is displayed.
	Cleanup



	G.4.12
	Select proc_prof.
	proc_prof is highlighted.
	Cleanup



	G.4.13
	Select Edit > Delete.
	A Confirm window prompts for confirmation.
	Cleanup



	G.4.14
	Click Yes.
	A Status Summary window appears indicating the Profile was successfully deleted.
	Cleanup



	G.4.15
	Click OK.
	Control returns to the Account and Profile Manager dialog box. The entry for ProCon has been removed from the Profiles tab.
	Cleanup



	G.4.16
	Click EXIT in the CDE Menu Bar.
	The Logout Confirmation window appears.
	Cleanup



	G.4.17
	Click OK.
	The DII COE Login screen appears.
	Cleanup



	G.4.18
	Login as sysadmin.
	The desktop appears.
	Cleanup



	G.4.19
	Select Applications > Application Manager > DII_APPS > SysAdm.
	The Application Manager – SysAdm window appears.
	Cleanup

	G.4.20
	Double-click Segment Installer.


	The Installer window appears.
	Cleanup

	G.4.21
	In the Installer window, select Processes Test Segment in the Currently Installed Segments field.
	Processes Test Segment in the Currently Installed Segments field is highlighted.
	Cleanup

	G.4.22
	Click Deinstall Software.


	An ENTER A PASSWORD dialog box appears.
	Cleanup

	G.4.23
	Enter the Master APM Authentication key in the text box.
	Asterisks appear in the text box.
	Cleanup



	G.4.24
	Click OK.
	The following dialog box appears:

Do you really want to remove the segments?

Processes Test Segment
	Cleanup

	G.4.25
	Click Yes.
	The working box may be blank, or the following dialog box will appear:

Segment deinstallation in progress...

The Installer window returns to the forefront.
	Cleanup

	G.4.26
	When removal is complete, check the Currently Installed Segments field.
	Processes Test Segment is no longer listed in the Currently Installed Segments field.
	Cleanup

	G.4.27
	Open a Terminal window.
	A Terminal window appears.
	Cleanup



	G.4.28
	At the command prompt type 

su
	The Password prompt appears.
	Startup

	G.4.29
	Enter the root password.
	The command prompt returns.
	Startup



	G.4.30
	At the command prompt type 

csh
	The command prompt returns.
	Startup

	G.4.31
	In the Terminal window, at the command prompt, type

rm /tmp/PROC*
	The command prompt returns.
	Cleanup

	H
	Verify Segment Installer Will Process Conflicts Descriptor

	H.1
	Install Conflicts Test Segment On the Candidate Platform (kpccp)
	

	H.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Installer window, click Select Source in the Source field.
	The Select Source window appears.
	Setup

	H.1.2
	In the Device field, click DISK.
	The DISK option is selected and the Select File dialog box appears.
	Setup

	H.1.3
	In the Selection text box type

/kpc/si/conflicts.tar
	/kpc/si/conflicts.tar appears in the text box.
	Setup

	H.1.4
	Click OK.
	The Select File and Select Source dialog boxes disappear.
	Setup

	H.1.5
	Click Read Contents.
	In the Installer window, Conflicts Test Segment is listed under Select Software To Install.
	Setup

	H.1.6
	Select Conflicts Test Segment.


	Conflicts Test Segment is highlighted and the Disk column in the Select Software To Install field displays /h.
	Setup

	H.1.7
	Click Install.
	The following dialog box appears:

Building segment lists…
The Installer window returns to the forefront and shows Conflicts Test Segment listed under Currently Installed Segments.
	Setup

	H.1.8
	In the Installer window, select Conflicts Test Segment in the Currently Installed Segments field.
	Conflicts Test Segment in the Currently Installed Segments field is highlighted.
	Setup

	H.1.9
	Click Deinstall Software.
	The following dialog box appears:

Do you really want to remove the segments?

Conflicts Test Segment
	Setup

	H.1.10
	Click Yes.
	The following dialog box appears:

Segment deinstallation in progress...

The Installer window returns to the forefront.
	Setup

	H.1.11
	When removal is complete, check both the Currently Installed Segments field and the Select Software To Install field.
	Conflicts Test Segment is no longer listed in the Currently Installed Segments field.

An asterisk (*) no longer appears next to Conflicts Test Segment in the Select Software To Install field.
	Setup

	H.1.12
	In the Installer window, click Select Source in the Source field.
	The Select Source window appears.
	Setup

	H.1.13
	In the Device field, click DISK.
	The DISK option is selected and the Select File dialog box appears.
	Setup

	H.1.14
	In the Filter box type:

/kpc/si/*
In the Files list box select

segx.tar
	segx.tar is highlighted.
	Setup

	H.1.15
	Click OK.
	The Select File and Select Source dialog boxes disappear.
	Setup

	H.1.16
	Click Read Contents.
	In the Installer window, Test Segment segx is listed under Select Software To Install.
	Setup

	H.1.17
	Select Test Segment segx.
	Test Segment segx is highlighted and the Disk column in the Select Software To Install field displays /h.
	Setup



	H.1.18
	Click Install.
	The following dialog box appears:

Building segment lists…
The Installer window returns to the forefront and shows Test Segment segx listed under Currently Installed Segments.
	Setup

	H.1.19
	In the Installer window, click Select Source in the Source field.
	The Select Source window appears.
	Setup

	H.1.20
	In the Device field, click DISK.
	The DISK option is selected and the Select File dialog box appears.
	Setup

	H.1.21
	In the Files list box select

conflicts.tar
	conflicts.tar is highlighted.
	Setup

	H.1.22
	Click OK.
	The Select File and Select Source dialog boxes disappear.
	Setup

	H.1.23
	Click Read Contents.
	In the Installer window, Conflicts Test Segment is listed under Select Software To Install.
	Setup

	H.1.24
	Select Conflicts Test Segment.


	Conflicts Test Segment is highlighted and the Disk column in the Select Software To Install field displays /h.
	Setup

	H.1.25
	Click Install.
	The following dialog box appears:

A conflicting segment of Conflicts Test Segment was found on disk
	Circle one:  PASS / FAIL



	H.1.26
	Click OK.
	The following dialog box appears:

Building segment lists…
The Installer window returns to the forefront and does not show Conflicts Test Segment listed under Currently Installed Segments field.
	Circle one:  PASS / FAIL



	I
	Verify Segment Installer Will Process Requires Descriptor

	I.1
	Install Requires Test Segment and Test Segment segy On the Candidate Platform (kpccp)
	

	I.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Installer window, click Select Source in the Source field.
	The Select Source window appears.
	Setup

	I.1.2
	In the Device field, click DISK.
	The DISK option is selected and the Select File dialog box appears.
	Setup

	I.1.3
	In the Files list box select

req_segy.tar
	req_segy.tar is highlighted.
	Setup

	I.1.4
	Click OK.
	The Select File and Select Source dialog boxes disappear.
	Setup

	I.1.5
	Click Read Contents.
	The following segments appear in the Select Software To Install field:

Test Segment segy

Requires Test Segment
	Setup

	I.1.6
	Select the following segment:
Requires Test Segment
	Requires Test Segment is highlighted.
Test Segment segy is not highlighted.
	Setup

	I.1.7
	Click Install.
	The following dialog box appears:

Please wait...extracting the disk file with the selected segment: ‘Requires Test Segment’
	Circle one:  PASS / FAIL



	I.1.8
	When installation is complete, check both the Currently Installed Segments field and the Select Software To Install field.
	Requires Test Segment and Test Segment segy are listed in the Currently Installed Segments field:

An asterisk (*) appears next to Requires Test Segment and Test Segment segy in the Select Software To Install field.
	Circle one:  PASS / FAIL



	I.2
	Deinstall Requires Test Segment, Test Segment segy, and Test Segment segx On the Candidate Platform (kpccp)
	

	I.2.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Installer window, select the following in the Currently Installed Segments field:

Requires Test Segment
Test Segment segy
Test Segment segx
	The three segments in the Currently Installed Segments field are highlighted.
	Setup

	I.2.2
	Click Deinstall Software.
	The following dialog box appears:

Do you really want to remove the segments?

Requires Test Segment
Test Segment segy
Test Segment segx
	Setup

	I.2.3
	Click Yes.
	The following dialog box appears:

Segment deinstallation in progress...

The Installer window returns to the forefront.
	Cleanup

	I.2.4
	When removal is complete, check the Currently Installed Segments field.
	The following segments are no longer listed in the Currently Installed Segments field:

Requires Test Segment
Test Segment segy
Test Segment segx
	Cleanup

	I.3
	Verify Requires Test Segment Will No Longer Install On the Candidate Platform (kpccp)
	

	I.3.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Select Software to Install field, select the following segment:
Requires Test Segment
	Requires Test Segment is highlighted.
Test Segment segy is not highlighted.
	Circle one:  PASS / FAIL



	I.3.2
	Click Install.
	The following dialog boxes appear in sequence:

Please wait...extracting the disk file with the selected segment: ‘Requires Test Segment’
	Circle one:  PASS / FAIL



	I.3.3
	When installation is complete, check both the Currently Installed Segments field and the Select Software To Install field.
	Requires Test Segment should not be listed in the Currently Installed Segments field:

An asterisk (*) should not appear next to Requires Test Segment in the Select Software To Install field:
	Circle one:  PASS / FAIL



	I.3.4
	Click Exit.
	The Installer window disappears.
	Circle one:  PASS / FAIL



	J
	Network Installation Server / Segment Installation Server Testing - Verify Feature Availability

	J.1
	Network Installation Server / Segment Installation Server - Main Window
	

	J.1.1
	NOTE: Perform the following steps on the Validation Host (kpchost) and Candidate Platform (kpccp).

In the Application Manager – SysAdm window, double-click Network Installation Server.
	The Segment Installation Server window appears.
	Circle one:  PASS / FAIL

 

	J.1.2
	Examine the Segment Installation Server windows on each platform.
	Size, shape, color and textural information on the Candidate Platform is similar to the Validation Host.  
	Circle one:  PASS / FAIL



	J.1.3
	NOTE: Perform the following steps on the Candidate Platform (kpccp)

Verify at the top of the screen, the following pull-down menus and their contents:
File
Source
Installed 
Contents 
Help (Grayed Out)

NOTE:  Each of these Menu Items/Functions are duplicates of buttons on the main screen and either choice produces the same results.
	The menu items are present and contain:

File –      Load
            Exit 

Source -    Select Source
            Read Contents

Installed – Release Notes
            Deinstall Software
            View Installation Log

Contents -  Release Notes
            Required Software
            Conflicting Software

Help -      (No Action)
	Circle one:  PASS / FAIL



	J.1.4
	Resize the Segment Installation Server window.
	The Segment Installation Server window resizes both larger and smaller. 
	Circle one:  PASS / FAIL



	J.1.5
	Minimize the Segment Installation Server window by clicking the dot in the right corner of the title bar.
	The Segment Installation Server window iconifies to the top left corner of the screen.
	Circle one:  PASS / FAIL



	J.1.6
	Restore the Segment Installation Server window by double-clicking on the Installer icon.
	The Segment Installation Server window restores to its previous  state.
	Circle one:  PASS / FAIL



	J.1.7
	Relocate the Segment Installation Server window.
	The Segment Installation Server window relocates anywhere on the screen.
	Circle one:  PASS / FAIL



	J.1.8
	Double-click the upper left corner of the Segment Installation Server window.
	The Segment Installation Server window disappears.
	Circle one:  PASS / FAIL



	J.1.9
	In the Application Manager – SysAdm window, double-click Network Installation Server. 
	The Segment Installation Server window appears.
	Circle one:  PASS / FAIL



	J.2
	Source Area - Verify Buttons and Fields Are Present On the Candidate Platform (kpccp)
	

	J.2.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Verify the following Source fields are present:

Host:
Device:
	All fields are present.
	Circle one:  PASS / FAIL



	J.2.2
	Verify the following buttons are present:

Select Source
Read Contents
	All buttons are present.
	Circle one:  PASS / FAIL



	J.2.3
	Verify information presented in the fields is correct:

Host:  LOCAL  kpccp
Device: DAT 
	The display reflects the current configuration.
	Circle one:  PASS / FAIL



	J.3
	Select Source - Verify the Functionality Of the Select Source Window; Select  Each Option On the Candidate Platform (kpccp)
	

	J.3.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Click Select Source.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	J.3.2
	Verify the following radio buttons are present:

Host:                       Device:

LOCAL         DISK      EXABYTE
REMOTE        DAT       OTHER
              CD-ROM
	All radio buttons are present and LOCAL and DAT are selected.

NOTE: Only certain combination work.

LOCAL - ALL  
REMOTE – DAT, EXABYTE, OTHER 

NOTE:  DISK and CD-ROM are accessible from a remote device if shared and mounted.
	Circle one:  PASS / FAIL



	J.3.3
	In the Host field, verify LOCAL is selected.
	LOCAL is selected.
	Circle one:  PASS / FAIL



	J.3.4
	In the Device field, select DISK.

	The Select File window appears.
	Circle one:  PASS / FAIL



	J.3.5
	Verify the existence of the following four sections:

Filter
Directories
Files
Selection
	Each of these sections is present.  The filtering section at the top can be used to find a particular file.
	Circle one:  PASS / FAIL



	J.3.6
	Verify the existence of four buttons at the bottom of the Select File window:

OK, Filter, Cancel, Help
	All buttons are present.
	Circle one:  PASS / FAIL



	J.3.7
	Click Cancel.
	The Select File window disappears.
	Circle one:  PASS / FAIL



	J.3.8
	Click OK.
	The Select Source window disappears and the Segment Installation Server window reappears.
	Circle one:  PASS / FAIL



	J.3.9
	Verify the information presented in the following fields is correct:

Host:  LOCAL  kpccp
Device: DISK
	The display reflects tester’s selections.
	Circle one:  PASS / FAIL



	J.3.10
	Click Select Source.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	J.3.11
	In the Host field, verify LOCAL is selected.


	LOCAL is selected.


	Circle one:  PASS / FAIL



	J.3.12
	In the Device field, select CD-ROM.
	The Select File window appears.
	Circle one:  PASS / FAIL



	J.3.13
	Verify the existence of the following four sections:

Filter
Directories
Files
Selection
	Each of these sections is present.  The filtering section at the top can be used to find a particular file.
	Circle one:  PASS / FAIL



	J.3.14
	Verify the existence of four buttons at the bottom of the Select File window:

OK, Filter, Cancel, Help
	All buttons are present.


	Circle one:  PASS / FAIL



	J.3.15
	Click Cancel.
	The Select File window disappears.
	Circle one:  PASS / FAIL



	J.3.16
	In the Select Source window under Device, Select EXABYTE.
	EXABYTE is selected.
	Circle one:  PASS / FAIL



	J.3.17
	In the Select Source window under Device, select Other.
	A text box appears for manually entering a device.
	Circle one:  PASS / FAIL



	J.3.18
	Enter the device path in the text box, e.g., /dev/rmt/0mn.
	The device path appears in the text box.
	Circle one:  PASS / FAIL



	J.3.19
	Click OK.
	The Segment Installation Server window appears and the Source field displays: 

Host:  LOCAL kpccp
Device: <device path>

where <device path> is the device file entered in the previous step, e.g., /dev/rmt/0mn
	Circle one:  PASS / FAIL



	J.3.20
	Click Select Source.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	J.3.21
	In the Select Source window under Device, click DAT.
	The DAT radio button is selected.
	Circle one:  PASS / FAIL



	J.3.22
	Click OK.
	The Segment Installation Server window appears and the Source field displays: 

Host:  LOCAL  kpccp
Device: DAT
	Circle one:  PASS / FAIL



	J.4
	Available Disks Panel Display On the Candidate Platform (kpccp)
	

	J.4.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Verify the Available Disks field displays the following columns:

Disk   Actual   Available   Selected   Reserved

Verify the button Reserved Space is greyed out.
	  Disk      Actual    Available    Selected    Reserved

  /h
  /home1   8.56MB    6.85MB     0.0 MB    1.71MB
 

                                          [ Reserved Space ]

NOTE: These values are approximate values and may vary slightly depending on the disk configuration. 

NOTE: See Known Problems 1 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	J.5
	Available Disks  - Reserved Space  -  Override Disk Space Allocation Window On the Candidate Platform (kpccp)
	

	J.5.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Select partition /home1 from the Available Disks field.
	/home1 is highlighted.


	Circle one:  PASS / FAIL



	J.5.2
	Click Reserved Space under Available Disks.
	An Override Disk Space Allocation window appears.
	Circle one:  PASS / FAIL



	J.5.3
	Verify the default value of Override Disk Space Limits.


	Default reads 80%.


	Circle one:  PASS / FAIL



	J.5.4
	Click on the Override Disk Space Limits button to show the pull-down menu.


	The Override Disk Space Limits are:

80%
(selected by default)
90%
95%
99%
	Circle one:  PASS / FAIL



	J.5.5
	Select 90%.
	The Override Disk Space Limits selection changes to 90%. 

	Circle one:  PASS / FAIL



	J.5.6
	Verify Clear and Set to Default box is not selected.


	Clear and Set to Default box is not selected.


	Circle one:  PASS / FAIL



	J.5.7
	Select and deselect the Clear and Set to Default box.


	The box toggles on and off.
	Circle one:  PASS / FAIL



	J.5.8
	Click Cancel.
	The Override Disk Space Allocation window disappears and the Available Disks values remain unchanged.
	Circle one:  PASS / FAIL



	J.5.9
	Click Reserved Space under Available Disks.
	An Override Disk Space Allocation window appears.
	Circle one:  PASS / FAIL



	J.5.10
	Click on the Override Disk Space Limits arrow to show the pull-down menu.


	The Override Disk Space Limits pull-down menu appears.


	Circle one:  PASS / FAIL



	J.5.11
	Select 99%.


	The Override Disk Space Limits selection changes to 99%. 

	Circle one:  PASS / FAIL



	J.5.12
	Click OK.
	The Available Disks field displays the 

 following approximate values:
   Disk      Actual    Available    Selected    Reserved

  /home1   8.56MB    8.47MB     0.0 MB    0.09MB

NOTE: These values are approximate values and may vary slightly depending on the disk configuration. 

NOTE: See Known Problems 1 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	J.5.13
	Click Reserved Space under Available Disks.
	An Override Disk Space Allocation window appears.
	Circle one:  PASS / FAIL



	J.5.14
	Verify Override Disk Space Limits selection is returned to 80%.  
	The Override Disk Space Limits selection is returned to 80%.
	Circle one:  PASS / FAIL



	J.5.15
	Click OK.
	The Available Disks field displays the 

 following approximate values:
  Disk      Actual    Available    Selected    Reserved

  /home1   8.56MB    6.85MB     0.0 MB    1.71MB

NOTE: These values are approximate values and may vary slightly depending on the disk configuration. 

NOTE: See Known Problems 1 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	J.6
	Available Disks  -  Verify the Information Presented For Actual Disk Size Is Correct On the Candidate Platform (kpccp)
	

	J.6.1
	In the Terminal window, at the command prompt type

df -k
	The /home1 disk space information is listed as follows:

Kbytes   used    available     Mounted on

 9751        61        8715           /home1

NOTE: These values are approximate values and may vary slightly depending on the disk configuration.
	Setup



	J.6.2
	To verify the disk space values shown under Available Disks, /home1, perform the following calculations:

Actual = avail(df -k) / 1024

Reserved = kbytes(df -k) * .9 * .2/1024

Available = Actual - Reserved
	Results are within 10 K of the values listed under Available Disks.  Values listed in the Segment Installation Server main window concur.

Actual     = 8.56MB

Reserved = 1.71MB

Available = 8.56 – 1.71 = 6.85MB

NOTE: These values are approximate values and may vary slightly depending on the disk configuration.
	Circle one:  PASS / FAIL

Actual:___________

Reserved:_________

Available:_________



	J.6.3
	In the Source field of the Segment Installation Server window, click Select Source.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	J.6.4
	In the Device field, select DISK.
	The Select File window appears.
	Circle one:  PASS / FAIL



	J.6.5
	 In the Filter text box type 

 /kpc/si/* [r]
	/kpc/si/* appears in the text box.
	Circle one:  PASS / FAIL



	J.6.6
	In the Files field, double-click bigseg.tar.
	The Select File window disappears. The Segment Installation Server window reappears.
	Circle one:  PASS / FAIL



	J.6.7
	Click Read Contents.
	The Segment Installation Server window returns with Big Test Segment appearing in the Select Software To Load field.
	Circle one:  PASS / FAIL



	J.6.8
	Select Big Test Segment in the Select Software to Load field.
	Big Test Segment is highlighted and the Disk column in the Select Software To Load field displays /home1.  If it doesn’t, deselect the segment and reselect it.  The Selected column in the  Available Disks field changes from 0.0MB to 0.10MB.
	Circle one:  PASS / FAIL



	J.6.9
	At the bottom of the Segment Installation Server window, click Load.
	An ENTER A PASSWORD dialog box appears asking for the master APM authentication key.
	Circle one:  PASS / FAIL



	J.6.10
	Enter the APM Authentication key in the text box.
	Asterisks appear in the text box.
	Circle one:  PASS / FAIL



	J.6.11
	Click OK.
	Big Test Segment installs correctly and is preceded by an * in the Select Software To Load field. Big Test Segment appears in the Segments Currently Loaded On This Network Server field.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	J.6.12
	Verify the  Available Disks, /home1 field values have changed.
	 The Available Disks field displays the 

 following approximate values:
Disk       Actual      Available    Selected    Reserved

 /home1   8.40MB    6.69MB     0.0 MB    1.71MB
NOTE: These values are approximate values and may vary slightly depending on the disk configuration.

NOTE: See Known Problems 1 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	J.6.13
	In the Segments Currently Loaded On This Network Server field, select Big Test Segment.
	Big Test Segment is highlighted.
	Circle one:  PASS / FAIL



	J.6.14
	Select Deinstall Software.
	A RESPOND TO THE QUESTION dialog box appears with the message: 

Do you really want to remove the segments?

Big Test Segment? 
	Circle one:  PASS / FAIL



	J.6.15
	Click Yes.
	Big Test Segment deinstalls correctly and is no longer preceded by an * in the Select Software To Load field. Big Test Segment no longer appears in the Segments Currently Loaded On This Network Server field.
	Circle one:  PASS / FAIL



	J.7
	Available Disks - Reserve Space 99% – Verify Segment Load On the Candidate Platform (kpccp)
	

	J.7.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp). 

In the  Terminal window, at the command prompt type
mkfile 4m /home1/fillspace

NOTE: This method is OS specific. Use the relevant method on the OS being tested and note it in the Observed Result column.
	 The command prompt returns.    
	Setup



	J.7.2
	In the Available Disks field click Reserved Space.
	The Override Disk Space Allocation window appears.
	Circle one:  PASS / FAIL



	J.7.3
	Change the Override Disk Space Limits value from 80% to 99%.  
	The 99% toggle is selected.
	Circle one:  PASS / FAIL



	J.7.4
	Click OK.


	 The Available Disks field displays the 

 following approximate values:
  Disk      Actual    Available    Selected    Reserved

 /home1   4.55MB   4.47MB     0.0 MB    0.09MB

NOTE: These values are approximate values and may vary slightly depending on the disk configuration. 

NOTE: See Known Problems 1 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	J.7.5
	Select Big Test Segment in the Select Software to Load field.
	Big Test Segment is highlighted and the Disk column in the Select Software To Load field displays /home1.  If it doesn’t, deselect the segment and reselect it. The Selected column in the Available Disks field changes from 0.0MB to 0.10MB.
	Circle one:  PASS / FAIL



	J.7.6
	At the bottom of the Segment Installation Server field click Load.
	 Big Test Segment loads correctly and is preceded by an * in the Select Software To Load field. Big Test Segment appears in the Segments Currently Loaded On This Network Server field.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	J.7.7
	In the Available Disks field verify the  /home1 values have changed.
	 The Available Disks field displays the 

 following approximate values:
  Disk      Actual      Available    Selected   Reserved

/home1   4.45MB     4.37MB      0.0 MB    4.09MB
NOTE: These values are approximate values and may vary slightly depending on the disk configuration. 

NOTE: See Known Problems 1 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	J.7.8
	In the Segments Currently Loaded On This Network Server field, select Big Test Segment.
	Big Test Segment is highlighted.
	Circle one:  PASS / FAIL



	J.7.9
	Click Deinstall Software.


	A RESPOND TO THE QUESTION dialog box appears with the message: 

Do you really want to remove the segments?

Big Test Segment?
	Circle one:  PASS / FAIL



	J.7.10
	Click Yes.
	Big Test Segment deinstalls correctly and is no longer preceded by an * in the Select Software To Load field. Big Test Segment no longer appears in the Segments Currently Loaded On This Network Server field.
	Circle one:  PASS / FAIL

 

	J.8
	Available Disks - No Space – Verify Segment Load Roll Over On the Candidate Platform (kpccp)
	

	J.8.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Available Disks field, click Reserved Space.
	The Override Disk Space Allocation window appears.
	Circle one:  PASS / FAIL



	J.8.2
	Click OK.  
	 The Available Disks field displays the 

 following approximate values:
 Disk      Actual    Available    Selected    Reserved

/home1   4.55MB    2.84MB     0.0 MB    1.71MB

NOTE: These values are approximate values and may vary slightly depending on the disk configuration. 

NOTE: See Known Problems 1 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	J.8.3
	Select Big Test Segment in the Select Software To Load field.
	Big Test Segment is highlighted and the Disk column in the Select Software To Load field displays /home1.  If it doesn’t, deselect the segment and reselect it.  

A Warning window appears stating that available disk space is not enough and the disk will be switched to next available disk.
	Circle one:  PASS / FAIL



	J.8.4
	Click OK in the Warning window.

	The Warning window disappears.
	Circle one:  PASS / FAIL



	J.8.5
	At the bottom of the Segment Installation Server field, click Load.


	Big Test Segment loads correctly and is preceded by an * in the Select Software To Load field. Big Test Segment appears in the Segments Currently Loaded On This Network Server field.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	J.8.6
	In the Available Disks field, verify /home1 values have remained the same and the segment loaded on /h (or the first available disk partition).
	 The Available Disks field displays the 

 following approximate values:
Disk      Actual    Available    Selected    Reserved

/home1   4.45MB    2.79MB    0.00 MB    1.71MB
NOTE: These values are approximate values and may vary slightly depending on the disk configuration. 

NOTE: See Known Problems 1 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	J.8.7
	In the Segments Currently Loaded On This Network Server field, select Big Test Segment.


	Big Test Segment is highlighted.


	Circle one:  PASS / FAIL



	J.8.8
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box appears with the message: 

Do you really want to remove the segments?

Big Test Segment?
	Circle one:  PASS / FAIL



	J.8.9
	Click Yes.
	Big Test Segment deinstalls correctly and is no longer preceded by an * in the Select Software To Load field. Big Test Segment no longer appears in the Segments Currently Loaded On This Network Server field.
	Circle one:  PASS / FAIL



	J.8.10
	Click Exit.
	The Segment Installation Server window disappears.
	Circle one:  PASS / FAIL



	J.9
	Available Disks - No Space – Verify Segment Installation Failure On the Candidate Platform (kpccp)
	

	J.9.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Terminal window at the command prompt type  

cd / 
	The command prompt returns.
	Setup



	J.9.2
	At the command prompt type

mv /home2 /newhome2 
	The command prompt returns.
	Setup



	J.9.3
	At the command prompt type

mkfile 950m /h/fillspace

NOTE: This method is OS specific. Use the relevant method on the OS being tested and note it in the Observed Result column.

NOTE: The file size parameter may vary, depending on the size of the /h partition. Create a file large enough to fill the /h partition up to at least 85%.
	NOTE: The command may take a few moments to complete.

The command prompt returns.
	Setup



	J.9.4
	In the Application Manager – SysAdm window, double-click Network Installation Server.
	The Segment Installation Server window appears.
	Circle one:  PASS / FAIL



	J.9.5
	Click Select Source in the Source field.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	J.9.6
	In the Device field, click DISK.


	The Select File window appears.
	Circle one:  PASS / FAIL



	J.9.7
	In the Filter text box type 

/kpc/si/* [r]
	/kpc/si/* appears in the text box.
	Circle one:  PASS / FAIL



	J.9.8
	In the Files field, double-click bigseg.tar
	Control returns to the Segment Installation Server window.
	Circle one:  PASS / FAIL



	J.9.9
	In the Available Disks field, select /home1.
	/home1 is highlighted.
	Circle one:  PASS / FAIL



	J.9.10
	In the Source field, click Read Contents.
	The Segment Installation Server window reappears with Big Test Segment under the Select Software To Load field.
	Circle one:  PASS / FAIL



	J.9.11
	Select Big Test Segment in the Select Software To Load field.
	A Warning window appears stating that available disk space is not enough. You may increase the available disk space using the Reserved Space Override.
	Circle one:  PASS / FAIL



	J.9.12
	Click OK.
	The Warning window disappears. Control returns to the Segment Installation Server window.
	Circle one:  PASS / FAIL



	J.9.13
	Click Exit.
	The Segment Installation Server window disappears.
	Circle one:  PASS / FAIL



	J.9.14
	At the command prompt type

mv /newhome2 /home2
	The command prompt returns.
	Cleanup

	J.9.15
	At the command prompt type
rm /h/fillspace /home1/fillspace
	The command prompt returns.
	Cleanup

	J.10
	Segments Currently Loaded On This Network Server Window On the Candidate Platform (kpccp)
	

	J.10.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Applications Manager – SysAdm window, double-click Network Installation Server.
	The Segment Installation Server window appears.
	Circle one:  PASS / FAIL



	J.10.2
	Verify that the following characteristics appear:

The Release Notes button is grayed out.

The Deinstall Software button is grayed out.
The Load button is grayed out.
The Exit button is available for selection. 
	The characteristics are displayed as noted.


	Circle one:  PASS / FAIL



	J.10.3
	In the Segment Installation Server window, in the Available Disks field, select /home1.

 
	/home1 is highlighted.


	Circle one:  PASS / FAIL



	J.10.4
	In the Source field, click Select Source.

 
	The Select Source window appears.
	Circle one:  PASS / FAIL



	J.10.5
	In the Device field, select DISK.
	The Select File window appears.
	Circle one:  PASS / FAIL



	J.10.6
	 In the Filter text box type 

 /kpc/si/* [r]
	/kpc/si/* appears in the text box.
	Circle one:  PASS / FAIL



	J.10.7
	In the Files field, double-click bigseg.tar.
	The Select File window disappears. The Segment Installation Server window reappears.
	Circle one:  PASS / FAIL



	J.10.8
	Click Read Contents.
	The Segment Installation Server window returns with Big Test Segment appearing in the Select Software To Load field.
	Circle one:  PASS / FAIL



	J.10.9
	Select Big Test Segment in the Select Software To Load field.
	Big Test Segment is highlighted and the Disk column in the Select Software To Load field displays /home1.  If it doesn’t, deselect the segment and reselect it.  The
Selected field in the Available Disks field changes from 0.0MB to 0.10MB.
	Circle one:  PASS / FAIL



	J.10.10
	At the bottom of the Segment Installation Server window select Load.
	An ENTER A PASSWORD dialog box appears asking for the master APM authentication key.
	Circle one:  PASS / FAIL



	J.10.11
	Enter the APM Authentication key in the text box.
	Asterisks appear in the text box.
	Circle one:  PASS / FAIL



	J.10.12
	Click OK.
	Big Test Segment installs correctly and is preceded by an * in the Select Software To Load field. Big Test Segment appears in the Segments Currently Loaded On This Network Server field.
	Circle one:  PASS / FAIL



	J.10.13
	Select Big Test Segment in the Segments Currently Loaded On This Network Server field.
	Big Test Segment is highlighted and the Disk column in the Select Software To Load field displays /home1.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL

	J.10.14
	Verify that the following characteristics appear:

The Release Notes button is available for selection in the Segments Currently Loaded On This Network Server field.

The Deinstall Software button is available for selection.

The Load button is grayed out.
The Exit button is available for selection.
	The characteristics are displayed as noted.


	Circle one:  PASS / FAIL



	J.10.15
	Click Release Notes.


	The Big Test Segment RELEASE NOTES are displayed.
	Circle one:  PASS / FAIL



	J.10.16
	Click OK.


	The RELEASE NOTES window disappears.
	Circle one:  PASS / FAIL



	J.10.17
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box appears with the message: 

Do you really want to remove the segments?

Big Test Segment
	Circle one:  PASS / FAIL



	J.10.18
	Click Yes.
	Big Test Segment deinstalls correctly and is no longer preceded by an * in the Select Software To Load field. Big Test Segment no longer appears in the Segments Currently Loaded On This Network Server field.
	Circle one:  PASS / FAIL



	K
	Local Devices Testing

	K.1
	Verify Segment Installation Server Can Read Table of Contents and Load Segments From A Local Tape Drive (DAT) On the Candidate Platform (kpccp)
	

	K.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Segment Installation Server window, click Select Source in the Source field.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	K.1.2
	In the Device field, select DAT.
	DAT is selected.


	Circle one:  PASS / FAIL



	K.1.3
	Click OK.
	The Segment Installation Server window reappears and the Source field displays: 

Host:  LOCAL  kpccp
Device: DAT
	Circle one:  PASS / FAIL



	K.1.4
	Insert the Test Segment segx tape into the local device.
	The tape drive initializes properly.
	Circle one:  PASS / FAIL



	K.1.5
	In the Source field, click Read Contents.
	The Segment Installation Server reads the Table of Contents.  When complete, the Segment Installation Server displays Test Segment segx in the Select Software To Load field.
	Circle one:  PASS / FAIL



	K.1.6
	In the Available Disks field, select /h.
	/h is highlighted.
	Circle one:  PASS / FAIL



	K.1.7
	Select Test Segment segx.
	Test Segment segx is highlighted and the Disk column in the Select Software To Load field displays /h.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	K.1.8
	Click Release Notes.
	The RELEASE NOTES window appears with the following header fields:

Name:
Test Segment segx

Version:
1.2.3.4

This segment is used when testing Segment Installer.
	Circle one:  PASS / FAIL



	K.1.9
	 Click OK.
	The RELEASE NOTES window disappears.
	Circle one:  PASS / FAIL



	K.1.10
	In the Select Software To Load field, click Requires.
	The REQUIRED SEGMENTS window appears with the following header fields:

Name:
Test Segment segx

Version:
1.2.3.4

 Name                     Version

COE Component Parent      4.0.0.0
	Circle one:  PASS / FAIL



	K.1.11
	 Click OK.
	The REQUIRED SEGMENTS window disappears.
	Circle one:  PASS / FAIL



	K.1.12
	In the Select Software To Load field, click Conflicts.
	The CONFLICTING SEGMENTS window appears with the following header fields:

Name:
Test Segment segx

Version:
1.2.3.4

Name                     Version Dummy Conflict Segment    (blank)
	Circle one:  PASS / FAIL



	K.1.13
	 Click OK.
	The CONFLICTING SEGMENTS window disappears.
	Circle one:  PASS / FAIL



	K.1.14
	Click Load.
	Test Segment segx loads accordingly under /h. Once loaded, it appears under the Select Software To Load field marked by an asterisk and is listed under the Segments Currently Loaded On This Network Server field.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	K.2
	Verify Segment Loads and Deinstalls Correctly On the Candidate Platform (kpccp)
	

	K.2.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

On the Segment Installation Server menu bar, select Installed > View Installation Log.
	The Install Log window appears.

Note: If the Network Installation Server died previously and was re-opened, the Installation Log will not be available.  Skip this and the next two steps.
	Circle one:  PASS / FAIL



	K.2.2
	Verify the segment loaded correctly.
	The Install Log indicates: 

Test Segment segx 1.2.3.4 successfully loaded on the kpccp Network Server.
	Circle one:  PASS / FAIL



	K.2.3
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	K.2.4
	In the Terminal window, at the command prompt, type 

ls /h/NET_SERVER
	The contents of the directory is listed with: 

segx:SOFTWARE:1.2.3.4:ALL
	Circle one:  PASS / FAIL



	K.2.5
	In the Segment Installation Server window, verify Test Segment segx is listed under Segments Currently Loaded On This Network Server.
	Test Segment segx is listed.
	Circle one:  PASS / FAIL



	K.2.6
	Under Segments Currently Loaded On This Network Server field select Test Segment segx.
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	K.2.7
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Test Segment segx
	Circle one:  PASS / FAIL



	K.2.8
	Click Yes.
	Test Segment segx deinstalls correctly and is no longer preceded by an * in the Select Software To Load field.  Test Segment segx no longer appears in the Segments Currently Loaded On This Network Server field.
	Circle one:  PASS / FAIL



	K.2.9
	On the Segment Installation Server menu bar, select Installed > View Installation Log.
	The Install Log window indicates: 

Segment (Test Segment segx) successfully de-installed.
	Circle one:  PASS / FAIL



	K.2.10
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	K.3
	Load A Segment To An Alternate Location  On the Candidate Platform (kpccp)
	

	K.3.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Available Disks field, select  /home1.
	/home1 is highlighted.
	Circle one:  PASS / FAIL



	K.3.2
	In the Select Software to Load field, select Test Segment segx.
	Test Segment segx is highlighted and the Disk column in the Select Software To Load field displays /home1.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	K.3.3
	Click Load.
	Test Segment segx loads accordingly under /home1.  Once loaded, it appears under Select Software To Load marked by an asterisk and is listed under Segments Currently Loaded On This Network Server.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	K.4
	Verify Successful Load Of Test Segment segx On the Alternate Location On the Candidate Platform (kpccp)
	

	K.4.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Terminal window, at the command prompt, type 

ls /home1/NET_SERVER
	The contents of the directory is listed with: 

segx:SOFTWARE:1.2.3.4:ALL
	Circle one:  PASS / FAIL



	K.4.2
	In the Segment Installation Server window, select Test Segment segx in the Segments Currently Loaded On This Network Server field.
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	K.4.3
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Test Segment segx
	Circle one:  PASS / FAIL



	K.4.4
	Click Yes.
	Test Segment segx deinstalls correctly and is no longer preceded by an * in the Select Software To Load field.  Test Segment segx no longer appears in the Segments Currently Loaded On This Network Server field.
	Circle one:  PASS / FAIL



	K.5
	Verify Segment Installation Server  Can Read Table Of Contents and Load Segments From A Local CD-ROM Drive On the Candidate Platform (kpccp)
	

	K.5.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Insert the KPC Test Data CD-ROM into the CD-ROM drive.
	The CD-ROM is inserted.
	Circle one:  PASS / FAIL



	K.5.2
	In the Segment Installation Server window, click Select Source in the Source field.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	K.5.3
	In the Device field, select CD-ROM. 
	The Select File window appears.
	Circle one:  PASS / FAIL



	K.5.4
	Enter the following in the Selection text box:

/cdrom/kpc_4204/segx.tar
	/cdrom/kpc_4204/segx.tar appears in the text box.
	Circle one:  PASS / FAIL



	K.5.5
	Click OK.
	The Segment Installation Server window reappears.
	Circle one:  PASS / FAIL



	K.5.6
	In the Source field, click Read Contents.
	The Segment Installation Server reads the Table of Contents.  When complete, the Segment Installation Server displays the Select Software To Load field. 
	Circle one:  PASS / FAIL



	K.5.7
	In the Available Disks field, verify /home1 is selected.
	/home1 is highlighted.
	Circle one:  PASS / FAIL



	K.5.8
	In the Select Software To Load field, select Test Segment segx.
	Test Segment segx is highlighted and the Disk column in the Select Software To Load field displays /home1.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	K.5.9
	Click Load.
	Test Segment segx loads accordingly under /home1. Once loaded, it appears under Select Software To Load marked by an asterisk and is listed under Segments Currently Loaded On This Network Server.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL

	K.6
	Verify Segment Loads and Deinstalls Correctly On the Candidate Platform (kpccp)
	

	K.6.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

On the Segment Installation Server menu bar, select Installed > View Installation Log.
	The Install Log window appears.

Note: If the Network Installation Server died previously and was re-opened, the Installation Log will not be available.  Skip this and the next two steps.
	Circle one:  PASS / FAIL



	K.6.2
	Verify the segment loaded correctly.
	The Install Log indicates: 

Test Segment segx 1.2.3.4 successfully loaded on kpccp Network Server.
	Circle one:  PASS / FAIL



	K.6.3
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	K.6.4
	In the Terminal window, at the command prompt, type 

ls /home1/NET_SERVER
	The contents of the directory is listed with: 

segx:SOFTWARE:1.2.3.4:ALL
	Circle one:  PASS / FAIL



	K.6.5
	In the Segment Installation Server window, verify Test Segment segx is listed under Segments Currently Loaded On This Network Server.
	Test Segment segx is listed.
	Circle one:  PASS / FAIL



	K.6.6
	In the Segments Currently Loaded On This Network Server field, select Test Segment segx.
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	K.6.7
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Test Segment segx
	Circle one:  PASS / FAIL



	K.6.8
	Click Yes.
	Test Segment segx deinstalls correctly and is no longer preceded by an * in the Select Software To Load field.  Test Segment segx no longer appears in the Segments Currently Loaded On This Network Server field.
	Circle one:  PASS / FAIL



	K.6.9
	On the Segment Installation Server menu bar, select Installed > View Installation Log.
	The Install Log window indicates:

Segment Test Segment segx) successfully de-installed.
	Circle one:  PASS / FAIL



	K.6.10
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	K.6.11
	In the Terminal window, at the command prompt, type 

ls /home1/NET_SERVER
	No files are listed.
	Circle one:  PASS / FAIL



	K.6.12
	At the command prompt type 

eject
	The CD-ROM is ejected.
	Cleanup 

	K.7
	Verify Segment Installation Server Can Read Table Of Contents and Load Segments From A Local Other Device On the Candidate Platform (kpccp)
	

	K.7.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Segment Installation Server window, click Select Source in the Source field.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	K.7.2
	In the Device field, click OTHER.
	OTHER is selected.

A text box appears for manually entering a device path.
	Circle one:  PASS / FAIL



	K.7.3
	In the OTHER text box, enter the device path of the local tape drive.  e.g.  /dev/rmt/0mn
	The text box accepts user input.
	Circle one:  PASS / FAIL



	K.7.4
	Click OK.
	The Segment Installation Server window reappears with correct information in the Source field.
	Circle one:  PASS / FAIL



	K.7.5
	Ensure the Test Segment segx tape is loaded in the local tape drive and that /home1 is selected in the Available Disks field.
	The tape is loaded and /home1 is selected.
	Setup



	K.7.6
	In the Source field, click Read Contents.
	The Segment Installation Server reads the Table of Contents.  When complete, The Segment Installation Server displays the Select Software To Load field.
	Circle one:  PASS / FAIL



	K.7.7
	In the Select Software To Load field, select Test Segment segx. 
	Test Segment segx is highlighted and the Disk column in the Select Software To Load field displays /home1.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	K.7.8
	Click Load.
	Test Segment segx loads accordingly under /home1.  Once loaded, it appears under Select Software To Load marked by an asterisk and is listed under Segments Currently Loaded On This Network Server.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	K.8
	Verify Segment Loads and Deinstalls Correctly On the Candidate Platform (kpccp)
	

	K.8.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

On the Segment Installation Server menu bar, select Installed > View Installation Log.
	The Install Log window appears.

Note: If the Network Installation Server died previously and was re-opened, the Installation Log will not be available.  Skip this and the next two steps.
	Circle one:  PASS / FAIL



	K.8.2
	Verify the segment loaded correctly.
	The Install Log indicates: 

Test Segment segx 1.2.3.4 successfully loaded on kpccp Network Server.
	Circle one:  PASS / FAIL



	K.8.3
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	K.8.4
	In the Terminal window, at the command prompt, type 

ls /home1/NET_SERVER
	The contents of the directory is listed with: 

segx:SOFTWARE:1.2.3.4:ALL
	Circle one:  PASS / FAIL



	K.8.5
	In the Segment Installation Server window, verify Test Segment segx is listed under Segments Currently Loaded On This Network Server.
	Test Segment segx is listed.
	Circle one:  PASS / FAIL



	K.8.6
	In the Segments Currently Loaded On This Network Server field, select Test Segment segx.
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	K.8.7
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Test Segment segx
	Circle one:  PASS / FAIL



	K.8.8
	Click Yes.
	Test Segment segx deinstalls correctly and is no longer preceded by an * in the Select Software To Load field.  Test Segment segx no longer appears in the Segments Currently Loaded On This Network Server field.
	Circle one:  PASS / FAIL



	K.8.9
	On the Segment Installation Server menu bar, select Installed > View Installation Log.
	The Install Log window indicates: 

Segment (Test Segment segx) successfully de-installed.
	Circle one:  PASS / FAIL



	K.8.10
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	K.8.11
	In the Terminal window, at the command prompt, type 

ls /home1/NET_SERVER
	No files are listed.
	Circle one:  PASS / FAIL



	K.8.12
	At the command prompt type 

mt rewoffl 


	The tape is ejected.
	Cleanup

	K.9
	Verify Segments Can Be Read and Load Segments From A Local Tape Drive 

 (Select Source  -  EXABYTE)  Optional test if vendor supports Exabyte drives
	

	L
	Remote Device Testing

	L.1
	Verify Segments Can Be Read, Installed, and De-installed From A Remote Tape Device  (DAT) On the Candidate Platform (kpccp)
	

	L.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Segment Installation Server window, click Select Source in the Source field. 
	The Select Source window appears.
	Circle one:  PASS / FAIL



	L.1.2
	In the Host field, select REMOTE.
	REMOTE is selected and a NAME text box appears.
	Circle one:  PASS / FAIL



	L.1.3
	Type kpchost in the NAME text box.


	kpchost appears in the NAME text box.


	Circle one:  PASS / FAIL



	L.1.4
	In the Device field, select DAT.
	DAT is selected.
	Circle one:  PASS / FAIL



	L.1.5
	Click OK.
	The Select Source window disappears. In the Source window of the Segment Installation Server, the Host: entry says REMOTE and the correct machine name.  Also the Device: entry selects the tape device you are using.
	Circle one:  PASS / FAIL



	L.1.6
	Insert the Test Segment segx tape into the remote device. 
	The tape drive initializes properly.
	Circle one:  PASS / FAIL



	L.1.7
	In the Source field, click Read Contents.
	The Segment Installation Server reads the Table of Contents.  When complete, The Segment Installation Server displays the Select Software To Load field.
	Circle one:  PASS / FAIL



	L.1.8
	Select Test Segment segx.


	Test Segment segx is highlighted and the Disk column in the Select Software To Load field displays /home1.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	L.1.9
	Click Load.
	The segment loads under /home1. Once loaded, it appears under Select Software To Load marked by an asterisk and is listed under Segments Currently Loaded On This Network Server.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	L.1.10
	In the Segments Currently Loaded On This Network Server field, select Test Segment segx.
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	L.1.11
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Test Segment segx
	Circle one:  PASS / FAIL



	L.1.12
	Click Yes.
	Test Segment segx deinstalls correctly and is no longer preceded by an * in the Select Software To Load field.  Test Segment segx no longer appears in the Segments Currently Loaded On This Network Server field.
	Circle one:  PASS / FAIL



	L.2
	Verify Segments Can Be Read, Installed, and De-installed From A Remote OTHER Device On the Candidate Platform (kpccp) 
	

	L.2.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the  Segment Installation Server window, click Select Source in the Source field.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	L.2.2
	In the Host field verify that REMOTE is selected.
	REMOTE is selected.
	Circle one:  PASS / FAIL



	L.2.3
	In the Device field, click OTHER.
	A text box appears to the right of the OTHER device selection.
	Circle one:  PASS / FAIL



	L.2.4
	In the OTHER text box, enter the appropriate device path for the remote tape drive, e.g., /dev/rmt/0mn.
	/dev/rmt/0mn appears in the text box.
	Circle one:  PASS / FAIL



	L.2.5
	Click OK.
	The Select Source window disappears. In the Source window of the Segment Installation Server, the Host: entry says REMOTE and the correct machine name.  Also the Device: entry displays the other device path.
	Circle one:  PASS / FAIL



	L.2.6
	Under Source, click Read Contents.
	The Segment Installation Server window will expand down to add a Select Software To Load section.
	Circle one:  PASS / FAIL



	L.2.7
	Select Test Segment segx.


	Test Segment segx is highlighted and the Disk column in the Select Software To Load field displays /home1.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	L.2.8
	Click Load.
	The segment loads under /home1. Once loaded, it appears under Select Software To Load marked by an asterisk and is listed under Segments Currently Loaded On This Network Server.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	L.2.9
	In the Segments Currently Loaded On This Network Server field, select Test Segment segx.
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	L.2.10
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Test Segment segx
	Circle one:  PASS / FAIL



	L.2.11
	Click Yes.
	Test Segment segx deinstalls correctly and is no longer preceded by an * in the Select Software To Load field.  Test Segment segx no longer appears in the Segments Currently Loaded On This Network Server field.
	Circle one:  PASS / FAIL



	L.2.12
	NOTE: Perform the following steps on the Validation Host (kpchost).

At the command prompt type 

mt rewoffl 


	The tape is ejected.
	Cleanup

	L.3
	Verify Segments Can Be Read, Installed, and De-installed From A Remote DISK Drive On the Candidate Platform (kpccp)
	

	L.3.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Segment Installation Server window, click Select Source, in the Source field.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	L.3.2
	In the Host field, click REMOTE.
	REMOTE is selected.
	Circle one:  PASS / FAIL



	L.3.3
	Type kpchost in the NAME text box. 
	kpchost appears in the NAME text box.
	Circle one:  PASS / FAIL



	L.3.4
	In the Device field, click DISK.
	The Select File window appears.
	Circle one:  PASS / FAIL



	L.3.5
	In the Filter text box type: 

/kpchostdsk/si/* [r]
	/kpchostdsk/si/* appears in the text box.
	Circle one:  PASS / FAIL



	L.3.6
	In the Files field, double-click bigseg.tar.
	The Select File window disappears. 

The Segment Installation Server window reappears.
	Circle one:  PASS / FAIL



	L.3.7
	Click Read Contents.
	The Segment Installation Server window returns with Big Test Segment appearing in the Select Software To Load field.
	Circle one:  PASS / FAIL



	L.3.8
	Select Big Test Segment in the Select Software to Load field.
	Big Test Segment is highlighted and the Disk column in the Select Software To Load field displays /home1.  If it doesn’t, deselect the segment and reselect it.  The Selected field in the Available Disks field changes from 0.0MB to 0.10MB.
	Circle one:  PASS / FAIL



	L.3.9
	At the bottom of the Segment Installation Server window, click Load.
	Big Test Segment loads accordingly under /home1.  Once loaded, it appears under Select Software To Load marked by an asterisk and is listed under Segments Currently Loaded On This Network Server.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	L.3.10
	In the Segments Currently Loaded On This Network Server field, select Big Test Segment.
	Big Test Segment is highlighted.
	Circle one:  PASS / FAIL



	L.3.11
	Click Deinstall Software.


	A RESPOND TO THE QUESTION dialog box appears with the message: 

Do you really want to remove the segments?

Big Test Segment?
	Circle one:  PASS / FAIL



	L.3.12
	Click Yes.
	Big Test Segment deinstalls correctly and is not preceded by an * in the Select Software To Load field.  Big Test Segment no longer appears in the Segments Currently Loaded On This Network Server field.
	Circle one:  PASS / FAIL



	L.3.13
	Click Exit.
	The Segment Installation Server window disappears.
	Circle one:  PASS / FAIL



	L.4
	Verify Segments Can Be Read and Loaded From A Remote CD-ROM Drive  
	

	L.4.1
	NOTE: Perform the following steps on the Validation host (kpchost).

Insert the KPC Test Data CD-ROM into the CD-ROM drive.
	The CD-ROM is inserted.
	Setup

	L.4.2
	In the Terminal window, at the command prompt type

share –o ro=kpccp /cdrom/kpc_4204
	The command prompt returns.
	Circle one:  PASS / FAIL

	L.4.3
	At the command prompt type

share 
	The following text is displayed:

/kpc ro=kpccp

/home2 ro,root=kpccp

/cdrom/kpc_4204 ro=kpccp
	Circle one:  PASS / FAIL

	L.4.4
	In the Terminal window type:

mount kpchost:/cdrom/kpc_4204 [s] /kpchostcdrom
	The command prompt returns.
	Circle one:  PASS / FAIL



	L.4.5
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Applications Manager – Sys Admin window, double click Network Installation Server.
	The Segment Installation Server window appears.
	Circle one:  PASS / FAIL



	L.4.6
	In the Source field, click Select Source.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	L.4.7
	In the Host field, select REMOTE.
	REMOTE is selected and a NAME text box appears.
	Circle one:  PASS / FAIL



	L.4.8
	Type kpchost in the NAME text box.


	kpchost appears in the NAME text box.


	Circle one:  PASS / FAIL



	L.4.9
	In the Device field, click CD-ROM.
	The Select File window appears.
	Circle one:  PASS / FAIL



	L.4.10
	Enter the following in the Selection text box:

/kpchostcdrom/segx.tar
	/kpchostcdrom/segx.tar appears in the text box.
	Circle one:  PASS / FAIL



	L.4.11
	Click OK.
	The Segment Installation Server window reappears.
	Circle one:  PASS / FAIL



	L.4.12
	In the Source field, click Read Contents.
	The Segment Installation Server reads the Table of Contents.  When complete, the Segment Installation Server displays the Select Software To Load field. 
	Circle one:  PASS / FAIL



	L.4.13
	In the Available Disks field select /home1.
	/home1 is highlighted.
	Circle one:  PASS / FAIL



	L.4.14
	In the Select Software to Load field, select Test Segment segx.
	Test Segment segx is highlighted and the Disk column in the Select Software To Load field displays /home1.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	L.4.15
	Click Load.
	An ENTER A PASSWORD dialog box appears asking for the master APM authentication key.
	Circle one:  PASS / FAIL



	L.4.16
	Enter the APM Authentication key in the text box.
	Asterisks appear in the text box.
	Circle one:  PASS / FAIL



	L.4.17
	Click OK.
	Test Segment segx loads accordingly under /home1.  Once loaded, it appears under Select Software To Load marked by an asterisk and is listed under Segments Currently Loaded On This Network Server.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	L.4.18
	In the Segments Currently Loaded On This Network Server field, select Test Segment segx.
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	L.4.19
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Test Segment segx
	Circle one:  PASS / FAIL



	L.4.20
	Click Yes.
	Test Segment segx deinstalls correctly and is no longer preceded by an * in the Select Software To Load field.  Test Segment segx no longer appears in the Segments Currently Loaded On This Network Server field.
	Circle one:  PASS / FAIL



	L.4.21
	Click Exit.
	The Segment Installation Server window closes.
	Circle one:  PASS / FAIL



	L.5
	Cleanup – Eject the CD-ROM on the Validation Host (kpchost)
	

	L.5.1
	NOTE: Perform the following steps on the Validation Host (kpchost).

In the Terminal window, at the command prompt type 
unshare /cdrom/kpc_4204
	The command prompt returns.
	Cleanup



	L.5.2
	At the command prompt type

share 
	The following text is displayed:

/kpc ro=kpccp

/home2 ro,root=kpccp
	Cleanup 

	L.5.3
	At the command prompt type 

eject
	The CD-ROM is ejected.
	Cleanup 

	L.6
	Verify Segments Can Be Read and Load Segments From A Remote Tape Drive  (Select Source  -  EXABYTE)

Optional test if vendor supports Exabyte drives
	Circle one:  PASS / FAIL



	M
	Network Installation Server / Segment Installation Server Testing – Load Many Segments

	M.1
	Network Installation Server / Segment Installation Server - Main Window On the Candidate Platform (kpccp)
	

	M.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp)

In the Application Manager – SysAdm window, double-click Network Installation Server.
	The Segment Installation Server window appears.


	Circle one:  PASS / FAIL



	M.1.2
	In the Segment Installation Server window, select the /home2 partition in the Available Disks field.
	/home2 is highlighted.
	Circle one:  PASS / FAIL



	M.1.3
	In the Source field, click Select Source.

 
	The Select Source window appears.
	Circle one:  PASS / FAIL



	M.1.4
	In the Host field, verify LOCAL is selected.
	LOCAL is selected.
	Circle one:  PASS / FAIL



	M.1.5
	In the Device field, select DISK.
	The Select File window appears.
	Circle one:  PASS / FAIL



	M.1.6
	 In the Filter text box type 

 /kpc/si/* [r]
	/kpc/si/* appears in the text box.
	Circle one:  PASS / FAIL



	M.1.7
	In the Files field, double-click bigseg.tar.
	The Select File window disappears. The Segment Installation Server window reappears.
	Circle one:  PASS / FAIL



	M.1.8
	In the Source field, click Read Contents.
	The Segment Installation Server window returns with Big Test Segment appearing in the Select Software To Load field.
	Circle one:  PASS / FAIL



	M.1.9
	Select Big Test Segment in the Select Software to Load field.
	Big Test Segment is highlighted and the Disk column in the Select Software To Load field displays /home2.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	M.1.10
	At the bottom of the Segment Installation Server window, click Load.
	An ENTER A PASSWORD dialog box appears asking for the master APM authentication key.
	Circle one:  PASS / FAIL



	M.1.11
	Enter the APM Authentication key in the text box.
	Asterisks appear in the text box.
	Circle one:  PASS / FAIL



	M.1.12
	Click OK.
	Big Test Segment installs correctly and is preceded by an * in the Select Software To Load field. Big Test Segment appears in the Segments Currently Loaded On This Network Server field.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	M.1.13
	In the Source field, click Select Source. 


	The Select Source window appears.
	Circle one:  PASS / FAIL



	M.1.14
	In the Device field, select DISK.
	The Select File window appears.
	Circle one:  PASS / FAIL



	M.1.15
	In the Files field, double-click badcpu.tar.
	The Select File window disappears. 

The Segment Installation Server window reappears.
	Circle one:  PASS / FAIL



	M.1.16
	In the Source field, click Read Contents.
	The Segment Installation Server window returns with Bad CPU Test Segment appearing in the Select Software To Load field.
	Circle one:  PASS / FAIL



	M.1.17
	Select Bad CPU Test Segment in the Select Software to Load field.
	Bad CPU Test Segment is highlighted and the Disk column in the Select Software To Load field displays /home2.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	M.1.18
	At the bottom of the Segment Installation Server window, click Load.
	Bad CPU Test Segment installs correctly and is preceded by an * in the Select Software To Load field. Bad CPU Test Segment appears in the Segments Currently Loaded On This Network Server field.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	M.1.19
	In the Source field, click Select Source. 


	The Select Source window appears.
	Circle one:  PASS / FAIL



	M.1.20
	In the Device field, select DISK.
	The Select File window appears.
	Circle one:  PASS / FAIL



	M.1.21
	In the Files field, double-click community.tar.
	The Select File window disappears. The Segment Installation Server window reappears.
	Circle one:  PASS / FAIL



	M.1.22
	In the Source field, click Read Contents.
	The Segment Installation Server window returns with Community Test Segment appearing in the Select Software To Load field.
	Circle one:  PASS / FAIL



	M.1.23
	Select Community Test Segment in the Select Software to Load field.
	Community Test Segment is highlighted and the Disk column in the Select Software To Load field displays /home2.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	M.1.24
	At the bottom of the Segment Installation Server window, click Load.
	Community Test Segment installs correctly and is preceded by an * in the Select Software To Load field. Community Test Segment appears in the Segments Currently Loaded On This Network Server field.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	M.1.25
	In the Source field, click Select Source. 


	The Select Source window appears.
	Circle one:  PASS / FAIL



	M.1.26
	In the Device field, select DISK.
	The Select File window appears.
	Circle one:  PASS / FAIL



	M.1.27
	In the Files field, double-click conflicts.tar.
	The Select File window disappears. 

The Segment Installation Server window reappears.
	Circle one:  PASS / FAIL



	M.1.28
	In the Source field, click Read Contents.
	The Segment Installation Server window returns with Conflicts Test Segment appearing in the Select Software To Load field.
	Circle one:  PASS / FAIL



	M.1.29
	Select Conflicts Test Segment in the Select Software to Load field.
	Conflicts Test Segment is highlighted and the Disk column in the Select Software To Load field displays /home2.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	M.1.30
	At the bottom of the Segment Installation Server window, click Load.
	Conflicts Test Segment installs correctly and is preceded by an * in the Select Software To Load field. Conflicts Test Segment appears in the Segments Currently Loaded On This Network Server field.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	M.1.31
	In the Source field, click Select Source. 


	The Select Source window appears.
	Circle one:  PASS / FAIL



	M.1.32
	In the Device field, select DISK.
	The Select File window appears.
	Circle one:  PASS / FAIL



	M.1.33
	In the Files field, double-click req_segy.tar.
	The Select File window disappears. 

The Segment Installation Server window reappears.
	Circle one:  PASS / FAIL



	M.1.34
	In the Source field, click Read Contents.
	The Segment Installation Server window returns with Requires Test Segment and Test Segment segy appearing in the Select Software To Load field.
	Circle one:  PASS / FAIL



	M.1.35
	Select Requires Test Segment and Test Segment segy in the Select Software To Load field.
	Requires Test Segment and Test Segment segy are highlighted.
	Circle one:  PASS / FAIL



	M.1.36
	At the bottom of the Segment Installation Server window, click Load.
	Requires Test Segment and Test Segment segy installs correctly and is preceded by an * in the Select Software To Load field. Requires Test Segment and Test Segment segy appear in the Segments Currently Loaded On This Network Server field.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	M.1.37
	In the Source field, click Select Source. 


	The Select Source window appears.
	Circle one:  PASS / FAIL



	M.1.38
	In the Device field, select DISK.
	The Select File window appears.
	Circle one:  PASS / FAIL



	M.1.39
	In the Files field, double-click segx.tar.
	The Select File window disappears. The Segment Installation Server window reappears.
	Circle one:  PASS / FAIL



	M.1.40
	In the Source field, click Read Contents.
	The Segment Installation Server window returns with Test Segment segx appearing in the Select Software To Load field.
	Circle one:  PASS / FAIL



	M.1.41
	Select Test Segment segx in the Select Software to Load field.
	Test Segment segx is highlighted and the Disk column in the Select Software To Load field displays /home2.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	M.1.42
	At the bottom of the Segment Installation Server window, click Load.
	Test Segment segx installs correctly and is preceded by an * in the Select Software To Load field. Test Segment segx appears in the Segments Currently Loaded On This Network Server field.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	M.1.43
	In the Source field, click Select Source.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	M.1.44
	In the Device field, click DISK.
	The Select File dialog box appears.
	Circle one:  PASS / FAIL



	M.1.45
	In the Files field, double-click all_types.tar.
	The Segment Installation Server window reappears.
	Circle one:  PASS / FAIL



	M.1.46
	In the Source field, click Read Contents.

NOTE: Resize the Segment Installation Server window to view all segments.
	The following segments appear in the Select Software to Load field:

Sample Aggregate Segment
Sample Account Group Segment
Sample COE Child Segment
Sample COTS Segment
Sample Data-Global Segment
Sample Data-Local Segment
Sample Data-Segment Segment
Sample Software Segment
SampleSW.P1
	Circle one:  PASS / FAIL



	M.1.47
	Select all segments in the Select Software To Load field.
	All requested segments in the Select   Software To Load field are highlighted.
	Circle one:  PASS / FAIL



	M.1.48
	Click Load.
	All the selected segments install correctly and are preceded by an * in the Select Software To Load field. All the selected segments appear in the Segments Currently Loaded On This Network Server field.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	M.2
	Verify Segments Loaded Correctly On the Segment Installation Server On the Candidate Platform (kpccp)
	

	M.2.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp)

In the Terminal window at the command prompt type

cd /home2
	The command prompt returns.
	Circle one:  PASS / FAIL



	M.2.2
	At the command prompt type 
ls -l
	The list includes NET_SERVER.
	Circle one:  PASS / FAIL



	M.2.3
	At the command prompt type 
cd NET_SERVER
	The command prompt returns.
	Circle one:  PASS / FAIL



	M.2.4
	At the command prompt type
ls -l
	The list includes the 17 segments listed in the Segments Currently Loaded On This Network Server field.
	Circle one:  PASS / FAIL



	M.2.5
	At the command prompt type
cd bigseg:SOFTWARE:1.2.3.4:ALL
	The command prompt returns.
	Circle one:  PASS / FAIL



	M.2.6
	At the command prompt type 
ls -l
	Two directories appear: 
SegDescrip
bigseg:SOFTWARE:1.2.3.4:ALL.tar
	Circle one:  PASS / FAIL



	M.2.7
	At the command prompt type
cd /h/data/global/SysAdm/TOC
	The command prompt returns
	Circle one:  PASS / FAIL



	M.2.8
	At the command prompt type 
ls -l
	The list includes the 17 segments listed in the Segments Currently Loaded On This Network Server field.
	Circle one:  PASS / FAIL



	M.2.9
	At the command prompt type
cd bigseg:SOFTWARE:1.2.3.4:ALL
	The command prompt returns.
	Circle one:  PASS / FAIL



	M.2.10
	At the command prompt type 
ls -l
	The directory SegDescrip appears.      
	Circle one:  PASS / FAIL



	M.2.11
	At the command prompt type
cd SegDescrip
	The command prompt returns
	Circle one:  PASS / FAIL



	M.2.12
	At the command prompt type
ls -l
	The following files appear:

DEINSTALL
FileAtttribs
ReleaseNotes
SegInfo
SegName
VERSION
Validated

cpp
	Circle one:  PASS / FAIL



	N
	Verify  Segment Installer On the Candidate Platform (kpccp) Can Read Table Of Contents and Install Segments From the Network Installation Server / Segment Installation Server

	N.1
	Segment Installation Server - Main Window On the Candidate Platform (kpccp)
	

	N.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Application Manager – SysAdm window, double-click Segment Installer.
	The Installer window appears.
	Circle one:  PASS / FAIL



	N.1.2
	In the Available Disks field, select /h.
	/h is highlighted and the Disk column in the Select Software To Install field displays /h.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	N.1.3
	In the Installer window, click Select Source in the Source field.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	N.1.4
	In the Device field, click NETWORK. 
	NETWORK is selected.

	Circle one:  PASS / FAIL



	N.1.5
	Click OK.
	The Installer window appears.
	Circle one:  PASS / FAIL



	N.1.6
	In the Source field, click Read Contents.
	The Installer reads the Table of Contents.  When complete, the Installer displays a Select Software To Install field.
	Circle one:  PASS / FAIL



	N.1.7
	In the Select Software to Install field, select Test Segment segx.
	Test Segment segx is highlighted and the Disk column in the Select Software To Install field displays /h.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	N.1.8
	Click Install.
	An ENTER A PASSWORD dialog box appears.
	Circle one:  PASS / FAIL



	N.1.9
	Enter the Master APM Authentication key in the text box.
	Asterisks appear in the text box.
	Circle one:  PASS / FAIL



	N.1.10
	Click OK.
	Test Segment segx installs accordingly under /h. Once installed, it appears under Select Software To Install marked by an asterisk and is listed under Currently Installed Segments.
	Circle one:  PASS / FAIL



	N.2
	Verify Segment Installs and Deinstalls Correctly On the Candidate Platform (kpccp)
	

	N.2.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

On the Installer menu bar, select Installed > View Installation Log.
	The Install Log window appears.

Note: If the Network Installation Server died previously and was re-opened, the Installation Log will not be available.  Skip this and the next two steps.
	Circle one:  PASS / FAIL



	N.2.2
	Verify the segment installed correctly.
	The Install Log indicates: 

Segment (Test Segment segx) successfully installed.
	Circle one:  PASS / FAIL



	N.2.3
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	N.2.4
	At the command prompt type

ls -l /h/segx
	The directory segx is listed with Integ, Scripts, SegDescrip, bin, and data subdirectories.
	Circle one:  PASS / FAIL



	N.2.5
	In the Installer window, select Test Segment segx in the Currently Installed Segments field.
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	N.2.6
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Test Segment segx
	Circle one:  PASS / FAIL



	N.2.7
	Click Yes.
	Test Segment segx deinstalls correctly and is no longer preceded by an * in the Select Software To Install field.  Test Segment segx no longer appears in the Currently Installed Segments field.
	Circle one:  PASS / FAIL



	O
	Verify Segment Installer On the Validation Host (kpchost) Can Read Table of Contents and Install Segments From the Network Installation Server / Segment Installation Server

	O.1
	Segment Installer - Main Window On the Validation Host (kpchost)
	

	O.1.1
	NOTE: Perform the following steps on the Validation Host (kpchost)

In the Application Manager – SysAdm window, double-click Segment Installer.
	The Installer window appears.
	Circle one:  PASS / FAIL



	O.1.2
	In the Available Disks field, select /h.
	/h is highlighted.
	Circle one:  PASS / FAIL



	O.1.3
	In the Installer window, click Select Source in the Source field.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	O.1.4
	In the Device field, click NETWORK. 
	NETWORK is selected.

	Circle one:  PASS / FAIL



	O.1.5
	Click OK.
	The Segment Installation Server window appears.
	Circle one:  PASS / FAIL



	O.1.6
	In the Source field, click Read Contents.
	The Installer reads the Table of Contents.  When complete, the Installer displays a Select Software To Install field.
	Circle one:  PASS / FAIL



	O.1.7
	In the Select Software to Install field, select Test Segment segx.
	Test Segment segx is highlighted and the Disk column in the Select Software To Install field displays /h.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	O.1.8
	Click Install.
	An ENTER A PASSWORD dialog box appears.
	Circle one:  PASS / FAIL



	O.1.9
	Enter the APM Authentication key in the text box.
	Asterisks appear in the text box.
	Circle one:  PASS / FAIL



	O.1.10
	Click OK.
	Test Segment segx installs accordingly under /h. Once installed, it appears under Select Software To Install marked by an asterisk and is listed under Currently Installed Segments.
	Circle one:  PASS / FAIL



	O.2
	Verify Segment Installs and Deinstalls Correctly On the Validation Host (kpchost)
	

	O.2.1
	NOTE: Perform the following steps on the Validation Host (kpchost).

On the Installer menu bar, select Installed > View Installation Log.
	The Install Log window appears.


	Circle one:  PASS / FAIL



	O.2.2
	Verify the segment installed correctly.
	The Install Log indicates: 

Segment (Test Segment segx) successfully installed.
	Circle one:  PASS / FAIL



	O.2.3
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	O.2.4
	At the command prompt type

ls  -l  /h/segx
	The directory segx is listed with Integ, Scripts, SegDescrip, bin, and data subdirectories.
	Circle one:  PASS / FAIL



	O.2.5
	In the Installer window, select Test Segment segx in the Currently Installed Segments field. 
	Test Segment segx is highlighted.
	Circle one:  PASS / FAIL



	O.2.6
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Test Segment segx
	Circle one:  PASS / FAIL



	O.2.7
	Click Yes.
	Test Segment segx deinstalls correctly and is no longer preceded by an * in the Select Software To Install field.  Test Segment segx no longer appears in the Currently Installed Segments field.
	Circle one:  PASS / FAIL



	O.2.8
	On the Segment Installation Server menu bar, select Installed > View Installation Log.
	The Install Log indicates: 

Segment (Test Segment segx) successfully de-installed.
	Circle one:  PASS / FAIL



	O.2.9
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	O.2.10
	Click Exit in the bottom menu bar of the Installer window.
	The Installer window disappears.
	Circle one:  PASS / FAIL



	P
	Network Installation Server / Segment Installation Server Testing – Verify Segments Deinstall Correctly

	P.1
	Network Installation Server / Segment Installation Server - Main Window On the Candidate Platform (kpccp)
	

	P.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Segments Currently Loaded On This Network Server field of the Segment Installation Server, select all 17 segments.
	All 17 segments are highlighted.
	Circle one:  PASS / FAIL



	P.1.2
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

(All 17 segments are listed).
	Circle one:  PASS / FAIL



	P.1.3
	Click Yes.
	The segments de-install and are not listed under Segments Currently Loaded On This Network Server.
	Circle one:  PASS / FAIL



	P.1.4
	On the Segment Installation Server menu bar, select Installed > View Installation Log.
	The Install Log indicates: 

(all test segments) successfully de-installed.
	Circle one:  PASS / FAIL



	P.1.5
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	P.1.6
	Click Exit in the bottom menu bar of the Segment Installation Server.
	The Segment Installation Server window disappears.
	Circle one:  PASS / FAIL



	Q
	Network Installation Server / Segment Installation Server Testing – Load Segment

	Q.1
	Network Installation Server / Segment Installation Server - Main Window On the Validation Host (kpchost)
	

	Q.1.1
	NOTE: Perform the following steps on the Validation Host (kpchost).

In the Segment Installation Server window, select the /home2 partition in the Available Disks field.
	/home2 is highlighted.
	Circle one:  PASS / FAIL



	Q.1.2
	In the Source field click Select Source.

 
	The Select Source window appears.
	Circle one:  PASS / FAIL



	Q.1.3
	In the Host field, verify LOCAL is selected.
	LOCAL is selected.
	Circle one:  PASS / FAIL



	Q.1.4
	In the Device field, select DISK.
	The Select File window appears.
	Circle one:  PASS / FAIL



	Q.1.5
	 In the Filter text, box type 

 /kpc/si/* [r]
	/kpc/si/* appears in the text box.
	Circle one:  PASS / FAIL



	Q.1.6
	In the Files field, double-click bigseg.tar.
	The Select File window disappears. The Segment Installation Server window reappears.
	Circle one:  PASS / FAIL



	Q.1.7
	In the Source field, click Read Contents.
	The Segment Installation Server window returns with Big Test Segment appearing in the Select Software To Load field.
	Circle one:  PASS / FAIL



	Q.1.8
	Select Big Test Segment in the Select Software To Load field.
	Big Test Segment is highlighted and the Disk column in the Select Software To Load field displays /home2.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	Q.1.9
	At the bottom of the Segment Installation Server window, click Load.
	Big Test Segment installs correctly and is preceded by an * in the Select Software To Load field. Big Test Segment appears in the Segments Currently Loaded On This Network Server field.

NOTE: See Known Problems 2 in the preamble of this procedure.
	Circle one:  PASS / FAIL



	R
	Verify Segment Installer On the Candidate Platform (kpccp) Can Read Table Of Contents and Install Segments From the Network Installation Server / Segment Installation Server

	R.1
	Segment Installer - Main Window On the Candidate Platform (kpccp)
	

	R.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Available Disks field of the Installer window, select /h.
	/h is highlighted.
	Circle one:  PASS / FAIL



	R.1.2
	In the Installer window, click Select Source in the Source field.
	The Select Source window appears.
	Circle one:  PASS / FAIL



	R.1.3
	In the Device field, click NETWORK. 
	NETWORK is selected.

	Circle one:  PASS / FAIL



	R.1.4
	Click OK.
	The Installer window appears.
	Circle one:  PASS / FAIL



	R.1.5
	In the Source field, click Read Contents.
	The Installer reads the Table of Contents.  When complete, the Installer displays a Select Software To Install field.
	Circle one:  PASS / FAIL



	R.1.6
	In the Select Software To Install field, select Big Test Segment.
	Big Test Segment is highlighted and the Disk column in the Select Software To Install field displays /h.  If it doesn’t, deselect the segment and reselect it.
	Circle one:  PASS / FAIL



	R.1.7
	Click Install.
	Big Test Segment installs accordingly under /h. Once installed, it appears under Select Software To Install marked by an asterisk and is listed under Currently Installed Segments.
	Circle one:  PASS / FAIL



	R.2
	Verify Segment Installs and Deinstalls Correctly On the Candidate Platform (kpccp)
	

	R.2.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

On the Installer menu bar, select Installed > View Installation Log.
	The Install Log window appears.

Note: If the Network Installation Server died previously and was re-opened, the Installation Log will not be available.  Skip this and the next two steps.
	Circle one:  PASS / FAIL



	R.2.2
	Verify the segment installed correctly.
	The Install Log indicates: 

Segment (Big Test Segment) successfully installed.
	Circle one:  PASS / FAIL



	R.2.3
	Click OK.
	The Install Log window disappears.
	Circle one:  PASS / FAIL



	R.2.4
	At the command prompt type

ls  -l  /h/bigseg
	The directory bigseg is listed with Integ, Scripts, SegDescrip, bin, and data subdirectories.
	Circle one:  PASS / FAIL



	R.2.5
	In the Installer window, select Big Test Segment in the Currently Installed Segments field. 
	Big Test Segment is highlighted.
	Circle one:  PASS / FAIL



	R.2.6
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Big Test Segment 
	Circle one:  PASS / FAIL



	R.2.7
	Click Yes.
	Big Test Segment deinstalls correctly and is no longer preceded by an * in the Select Software To Install field.  Big Test Segment no longer appears in the Currently Installed Segments field.
	Circle one:  PASS / FAIL



	R.2.8
	Click Exit in the bottom menu bar of the Installer window.
	The Installer window disappears.
	Circle one:  PASS / FAIL



	S
	Network Installation Server / Segment Installation Server Testing – Verify Segments De-install Correctly

	S.1
	Network Installation Server / Segment Installation Server - Main Window On the Validation Host (kpchost)
	

	S.1.1
	NOTE: Perform the following steps on the Validation Host (kpchost).

In the Segments Currently Loaded On This Network Server field, select Big Test Segment.
	Big Test Segment is highlighted.
	Cleanup



	S.1.2
	Click Deinstall Software.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

Big Test Segment
	Cleanup



	S.1.3
	Click Yes.
	The segment de-installs and is no longer listed under the Segments Currently Loaded On This Network Server field.
	Cleanup



	S.1.4
	Click Exit in the bottom menu bar of the Segment Installation Server.
	The Segment Installation Server window disappears.
	Cleanup



	T
	Launch Segment Installer From the Command Line

	T.1
	Launch Segment Installer From the Command Line On the Candidate Platform (kpccp)
	

	T.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Open a new Terminal window.
	A Terminal window appears with a command line prompt.
	Startup

	T.1.2
	At the command prompt type 

/h/COE/bin/COEInstaller –h
	The following appears:

Usage:  COEInstaller [flags}
-h –H   Display this help message.
-c   <file> Read command line arguments from the
        named <file>.
-d    Set the debug flag.
-s    Run in installation server mode.
-v    Show verbose messages while the tool runs.
-V   Display the tool’s version number.
-w   Suppress all warnings.
	Circle one:  PASS / FAIL



	T.1.3
	In the Terminal window, at the command prompt type the following as sysadmin:

/h/COE/bin/COEInstaller –v
	The Installer window opens.
	Circle one:  PASS / FAIL



	T.1.4
	Click Exit in the bottom menu bar of the Installer.
	The Installer window disappears.
	Circle one:  PASS / FAIL



	T.1.5
	In the Terminal window select

Window > Close
	The Terminal window closes.
	Circle one:  PASS / FAIL



	U
	 Segment Installation Post Test Cleanup

    NOTE:  These steps restore the Test Cell to pretest conditions.

   These steps or a restore from backup may be preformed at the tester’s discretion. 

 Candidate Platform Cleanup

	U.1
	Launch Edit Local Hosts and Remove kpchost Entry On the Candidate Platform (kpccp)
	

	U.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Application Manager – SysAdm window, double-click Edit Local Hosts.
	The Edit Hosts window appears.
	Cleanup

	U.1.2
	 Select kpchost. 
	kpchost is highlighted.
	Cleanup



	U.1.3
	 Click Delete.
	A Confirmation Required window appears.
	Cleanup



	U.1.4
	 Click Yes.
	The Confirmation Required window disappears.
	Cleanup



	U.1.5
	 Click Close.


	The Edit Hosts window disappears.
	Cleanup

	U.2
	Modify /etc/inetd.conf and /.rhosts To Disable rsh (Close Security For Remote Shell) On the Candidate Platform (kpccp)
	

	U.2.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Terminal window, at the command prompt type 

su 

NOTE: Do not use the "-" option.
	The Password prompt appears.
	Cleanup

	U.2.2
	Enter the root password.
	The command prompt returns.
	Cleanup


	U.2.3
	At the command prompt type 

csh
	The command prompt returns.
	Cleanup

	U.2.4
	In the Terminal window, at the command prompt type

vi /etc/inetd.conf
	The file /etc/inetd.conf is opened for editing.
	Cleanup


	U.2.5
	Type

/shell
	The vi editor will place the cursor on the line that contains:

shell
	Cleanup


	U.2.6
	Type 

n

until the cursor is at the beginning of the line contianing

shell stream tcp nowait root
	The cursor is over the s on the line with 

shell stream tcp nowait root
	Cleanup

	U.2.7
	Type

i
	The vi editor will enter insert mode.
	Cleanup


	U.2.8
	Type

#
	The vi editor will add the # symbol.
	Cleanup


	U.2.9
	Press

[esc]
	The vi exits the Insert Mode.
	Cleanup


	U.2.10
	Type

:wq!
	The vi editor will write to and exit the file.

The command prompt returns.
	Cleanup


	U.2.11
	At the command prompt type

ps –eaf | grep inetd
	Process information for inetd appears with the process id in the second column.
	Cleanup


	U.2.12
	At the command prompt type

kill –HUP <pid>
where <pid> is the process ID found in the previous step.
	The command prompt appears.
	Cleanup


	U.2.13
	In the Terminal window, at the command prompt type

vi /.rhosts
	The file /.rhosts is opened for editing.
	Cleanup


	U.2.14
	Type

dd
	The vi editor removes kpchost.
	Cleanup


	U.2.15
	Type

i
	The vi editor will enter insert mode.
	Cleanup


	U.2.16
	Type

- 
	The vi editor inserts - to the file.
	Cleanup


	U.2.17
	Press

[esc]
	The vi exits the Insert Mode.
	Cleanup


	U.2.18
	Type

:wq!
	The vi editor will write to and exit the file.

The command prompt returns.
	Cleanup


	U.3
	Unexport /h/data/global and /home2 Directories From the Candidate Platform (kpccp)
	

	U.3.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Application Manager - SysAdm window, double-click Disk Manager.
	The Disk Manager window appears.
	Cleanup


	U.3.2
	Select the row that contains the / partition in the Mounted On column.
	The / row is highlighted.
	Cleanup


	U.3.3
	Click Export FS.
	The Export/Unexport File Systems window appears.
	Cleanup

	U.3.4
	Click Current.
	The following text is displayed:

/h/data/global  -o rw,root=kpchost
/home2 –o ro,root=kpchost
	Cleanup

	U.3.5
	Click OK.
	The Current Exports window disappears.
	Cleanup



	U.3.6
	In the pathname text box, type: 

/h/data/global
	/h/data/global appears in the pathname text box.
	Cleanup

	U.3.7
	Click Unexport.
	A Confirmation window appears asking: UnExport this directory permanently?
	Cleanup

	U.3.8
	Click Yes.
	The Confirmation window disappears and control returns to the Disk Manager window.
	Cleanup

	U.3.9
	Click Export FS.
	The Export/Unexport File Systems window appears.
	Cleanup

	U.3.10
	In the pathname text box, type: 

/home2
	/home2 appears in the pathname text box.
	Cleanup

	U.3.11
	Click Unexport.
	A Confirmation window appears asking: UnExport this directory permanently?
	Cleanup

	U.3.12
	Click Yes.
	The Confirmation window disappears and control returns to the Disk Manager window.
	Cleanup

	U.3.13
	Click Export FS.
	The Export/Unexport File Systems window appears.
	Cleanup

	U.3.14
	Click Current.
	The Current Exports window is empty.
	Cleanup



	U.3.15
	Click OK.
	The Current Exports window disappears.
	Cleanup



	U.3.16
	Click Cancel.
	The Export/Unexport File Systems window disappears.
	Cleanup

	U.4
	Unmount /kpc and /cdrom/kpc_4204 Directories From the Validation Host (kpchost) On the Candidate Platform (kpccp)
	

	U.4.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

In the Disk Manager window, select the row that contains the /kpchostdsk in the Mounted On column.
	The /kpchostdsk row is highlighted.
	Cleanup


	U.4.2
	Click Unmount.
	A Confirmation window asks:  

Unmount the File System Permanently?
	Cleanup

	U.4.3
	Click  Yes.
	The Confirmation window disappears and control returns to the Disk Manager window. /kpchostdsk disappears as a file system. 
	Cleanup

	U.4.4
	Select the row that contains the /kpchostcdrom in the Mounted On column.
	The /kpchostcdrom row is highlighted.
	Cleanup


	U.4.5
	Click Unmount.
	A Confirmation window asks:  

Unmount the File System Permanently?
	Cleanup

	U.4.6
	Click Yes.
	The Confirmation window disappears and control returns to the Disk Manager window. /kpchostcdrom disappears as a file system. 
	Cleanup

	U.4.7
	Click Exit. 
	The Disk Manager window disappears.
	Cleanup



	U.5
	 Remove Directories On the Candidate Platform (kpccp)
	

	U.5.1
	 NOTE: Perform the following steps on the Candidate Platform (kpccp).

At the command prompt type

cd /
	The command prompt returns.
	Cleanup

	U.5.2
	At the command prompt type

rmdir /kpchostdsk /kpchostcdrom
	The command prompt returns.
	Cleanup


	U.6
	Test Data De-installation
	

	U.6.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Select Applications > Application Manager > DII_APPS.
	The Application Manager window appears.
	Cleanup


	U.6.2
	Double-click Segment Installer in the Application Manager – SysAdm window.
	The  Installer window appears.
	Cleanup 



	U.6.3
	In the Currently Installed Segments list  select KPC Test Data for 4200P4.
	KPC Test Data for 4200P4 is highlighted
	Cleanup 



	U.6.4
	Click Deinstall Software.


	An ENTER A PASSWORD dialog box appears.
	Cleanup

	U.6.5
	Enter the Master APM Authentication key in the text box.
	Asterisks appear in the text box.
	Cleanup



	U.6.6
	Click OK.
	A RESPOND TO THE QUESTION dialog box asks: 

Do you really want to remove the segments?

KPC Test Data for 4200P4
	Cleanup

	U.6.7
	Click Yes.
	KPC Test Data for 4200P4 deinstalls correctly and is no longer preceded by an * in the Select Software To Install field. KPC Test Data for 4200P4 no longer appears in the Currently Installed Segments field.
	Cleanup 

	U.6.8
	Click Exit.
	The Installer window disappears.
	Cleanup 



	V
	 Segment Installation Post Test Cleanup

    NOTE:  These steps restore the Test Cell to pretest conditions.

   These step or a restore from backup may be preformed at the tester’s discretion. 

 Validation Host Cleanup

	V.1
	Launch Edit Local Hosts and Remove kpccp Entry On the Validation Host (kpchost)
	

	V.1.1
	NOTE: Perform the following steps on the Validation Host (kpchost).

In the Application Manager – SysAdm window, double-click Edit Local Hosts.
	The Edit Hosts window appears.
	Cleanup

	V.1.2
	 Select kpccp. 
	kpccp is highlighted.
	Cleanup



	V.1.3
	 Click Delete.
	A Confirmation Required window appears.
	Cleanup



	V.1.4
	 Click Yes.
	The Confirmation Required window disappears.
	Cleanup



	V.1.5
	 Click Close.
	The Edit Hosts window disappears.
	Cleanup



	V.2
	Modify /etc/inetd.conf and /.rhosts To Disable rsh (Close Security For Remote Shell) On the Validation Host (kpchost)
	

	V.2.1
	NOTE: Perform the following steps on the Validation Host (kpchost).

In the Terminal window, at the command prompt type

vi /etc/inetd.conf
	The file /etc/inetd.conf is opened for editing.
	Cleanup


	V.2.2
	Type

/shell
	The vi editor will place the cursor on the line that contains:

shell
	Cleanup


	V.2.3
	Type 

n

until the cursor is at the beginning of the line contianing

shell stream tcp nowait root
	The cursor is over the s on the line with 

shell stream tcp nowait root
	Cleanup

	V.2.4
	Type

i
	The vi editor will enter insert mode.
	Cleanup


	V.2.5
	Type

#
	The vi editor will add the # symbol.
	Cleanup


	V.2.6
	Press

[esc]
	The vi editor exits Insert Mode.
	Cleanup


	V.2.7
	Type

:wq!
	The vi editor will write to and exit the file.

The command prompt returns.
	Cleanup


	V.2.8
	At the command prompt type

ps –eaf | grep inetd
	Process information for inetd appears with the process id in the second column.
	Cleanup


	V.2.9
	At the command prompt type

kill –HUP <pid>
where <pid> is the process ID found in the previous step.
	The command prompt appears.
	Cleanup


	V.2.10
	In the Terminal window, at the command prompt type

vi /.rhosts
	The file /.rhosts is opened for editing.
	Cleanup


	V.2.11
	Type

dd
	The vi editor removes kpccp.
	Cleanup


	V.2.12
	Type

i
	The vi editor will enter insert mode.
	Cleanup


	V.2.13
	Type

- 
	The vi editor inserts - to the file.
	Cleanup


	V.2.14
	Press

[esc]
	The vi editor exits Insert Mode.
	Cleanup


	V.2.15
	Type

:wq!
	The vi editor will write to and exit the file.

The command prompt returns.
	Cleanup


	V.3
	Unexport /kpc Directory From the Validation Host (kpchost)
	

	V.3.1
	NOTE: Perform the following steps on the Validation Host (kpchost).

In the Application Manager - SysAdm window, double-click Disk Manager.
	The Disk Manager window appears.
	Cleanup


	V.3.2
	Select the row that contains the / partition in the Mounted On column.
	The / row is highlighted.
	Cleanup


	V.3.3
	Click Export FS.
	The Export/Unexport File Systems window appears.
	Cleanup

	V.3.4
	Click Current.
	The following text is displayed:

/kpc ro=kpccp

/home2 –o ro,root=kpccp
	Cleanup

	V.3.5
	Click OK.
	The Current Exported File Systems window disappears.
	Cleanup



	V.3.6
	In the pathname text box, type: 

/kpc
	/kpc appears in the pathname text box.
	Cleanup

	V.3.7
	Click Unexport.
	A Confirmation window appears asking: UnExport this directory permanently?
	Cleanup

	V.3.8
	Click Yes.
	The Confirmation window disappears and control returns to the Disk Manager window.
	Cleanup

	V.3.9
	Click Export FS.
	The Export/Unexport File Systems window appears.
	Cleanup

	V.3.10
	In the pathname text box, type: 

/home2
	/home2 appears in the pathname text box.
	Cleanup

	V.3.11
	Click Unexport.
	A Confirmation window appears asking: UnExport this directory permanently?
	Cleanup

	V.3.12
	Click Yes.
	The Confirmation window disappears and control returns to the Disk Manager window.
	Cleanup

	V.3.13
	Click Export FS.
	The Export/Unexport File Systems window appears.
	Cleanup

	V.3.14
	Click Current.
	The Current Exported File Systems window is empty.
	Cleanup



	V.3.15
	Click OK.
	The Current Exports window disappears.
	Cleanup



	V.3.16
	Click Cancel.
	The Export/Unexport File Systems window disappears.
	Cleanup



	V.4
	Unmount /h/data/global Directory From the Candidate Platform (kpccp) On the Validation Host (kpchost)
	

	V.4.1
	NOTE: Perform the following steps on the Validation Host (kpchost).

Select the row that contains the /h/data/global in the Mounted On column.
	The /h/data/global row is highlighted.
	Cleanup


	V.4.2
	Click Unmount.
	A Confirmation window asks:  

Unmount the File System Permanently?
	Cleanup

	V.4.3
	Click Yes.
	The Confirmation window disappears and control returns to the Disk Manager window. /h/data/global disappears as a file system. 
	Cleanup

	V.4.4
	Click Exit. 
	The Disk Manager window disappears.
	Cleanup



	Z
	Log Out On the Candidate Platform (kpccp) and Validation Host (kpchost)

	Z.1
	Validation Host (kpchost) Log Out
	

	Z.1.1
	NOTE: Perform the following steps on the Validation Host (kpchost).

Close all open windows.
	All open windows close.
	Cleanup

	Z.1.2
	Click EXIT in the CDE Menu Bar.
	The Logout Confirmation window appears.
	Cleanup



	Z.1.3
	Click OK.
	The DII COE Login screen appears.
	Cleanup



	Z.2
	Candidate Platform (kpccp) Log Out
	

	Z.2.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Close all open windows.
	All open windows close.
	Cleanup

	Z.2.2
	Click EXIT in the CDE Menu Bar.
	The Logout Confirmation window appears.
	Cleanup



	Z.2.3
	Click OK.
	The DII COE Login screen appears.
	Cleanup




End of Validation Procedure

Appendix A

Procedure for creating a test data tape that includes segx, which is required for this test.

	ZZ
	Setup – Create Test Data Tape That Includes segx

	ZZ.1
	Setup – Install DII COE Developer’s Toolkit and Put Test Segment segx On Tape On the Candidate Platform (kpccp)
	

	ZZ.1.1
	NOTE: Perform the following steps on the Candidate Platform (kpccp).

Login as sysadmin.
	The desktop appears.
	Startup

	ZZ.1.2
	Select Applications > Application Manager > DII_APPS > SysAdm.
	The Application Manager – SysAdm window appears.
	Startup

	ZZ.1.3
	Insert the DII COE Developer’s Toolkit tape into the tape drive.
	The tape is accepted.
	Setup

	ZZ.1.4
	Double-click Segment Installer.
	The Installer window appears.
	Startup



	ZZ.1.5
	Click Read Contents.
	The Installer window shows Developer’s Toolkit listed under Select Software To Install.
	Startup

	ZZ.1.6
	Select DII COE Developer’s Toolkit.
	DII COE Developer’s Toolkit is highlighted.
	Startup

	ZZ.1.7
	Click Install.
	An ENTER A PASSWORD dialog box appears.
	Startup



	ZZ.1.8
	Enter the APM Authentication key in the text box.
	Asterisks appear in the text box.
	Startup



	ZZ.1.9
	Click OK.
	The dialog box disappears. 

The Installer window shows DII COE Developer’s Toolkit listed under Currently Installed Segments.
	Startup

	ZZ.1.10
	Click Exit in the lower menu bar.
	The Installer window disappears.
	Setup



	ZZ.1.11
	Open a Terminal window.
	A Terminal window appears with a command line prompt.
	Startup

	ZZ.1.12
	At the command prompt type 

su 

NOTE: Do not use the "-" option.
	The Password prompt returns.
	Startup

	ZZ.1.13
	Enter the root password.
	The command prompt returns.
	Startup



	ZZ.1.14
	At the command prompt type 

csh
	The command prompt returns.
	Startup

	ZZ.1.15
	Insert a blank tape into the tape drive.
	The tape is inserted.
	Setup



	ZZ.1.16
	At the command prompt type

mt rew
NOTE: This command is OS specific and assumes that /dev/rmt/0m is the default tape device address. Use the relevant command on the OS being tested and note it in the Observed Result column.
	The tape is rewound.
	Setup

	ZZ.1.17
	At the command prompt type

/h/DII_DEV/bin/MakeInstall –t [s] <device path> -p /kpc/tk segx 

where <device path> is the device address of a ‘no rewind’ tape device. (e.g. /dev/rmt/0mn)
	Messages/information will appear in the Terminal window indicating the process steps being executed by MakeInstall. The following prompt appears:

Enter the size of the tape in MByte or type ‘q’ to quit.
	Setup

	ZZ.1.18
	At the prompt type

80
	The following prompt appears:

Processing Segment /kpc/tk/segx
	Setup

	ZZ.1.19
	At the prompt type

NO
	The following prompt appears:

Processing segment: /kpc/tk/MIseg

Enter your name for the Tape Header:
	Setup

	ZZ.1.20
	Press ENTER.
	The following prompt appears:

Enter a serial number for the Tape Header:
	Setup

	ZZ.1.21
	Press ENTER.
	The following prompt appears:

Enter any desired comment to put in the Tape Header (up to 255 characters) :
	Setup

	ZZ.1.22
	Press ENTER.
	MakeInstall will continue and display the following information:

1. A segment description table.

2. The number of segments to be written to output device (1).

3. Space requirements for segment.

The following prompt appears:

Insert tape #1

Press any key to continue.
	Setup

	ZZ.1.23
	Press ENTER.
	The following prompt appears:

DII Install tape completed.
	Setup

	ZZ.1.24
	At the command prompt type

mt rewoffl

NOTE: This command is OS specific and assumes that /dev/rmt/0m is the default tape device address. Use the relevant command on the OS being tested and note it in the Observed Result column.
	The tape is rewound and ejected.
	Cleanup

	ZZ.1.25
	NOTE: This tape may be used for all subsequent Segment Installer Validation Tests.
	
	


End of Appendix A

Segment Installer Validation Procedure
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